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PlantPAx Distributed Control System - Template User Manual User Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which 
may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, 
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage 
may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc 
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory 
requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

This template user manual describes how to leverage virtual image templates 
when deploying a virtualized PlantPAx® Distributed Control System (DCS). 
PlantPAx virtual image templates are pre-configured, virtual system elements 
of your PlantPAx system.

This manual also describes how to manage and configure templates as 
individual virtual system elements, and how to configure them to work 
together.

• Define and Procure - Helps you understand the elements of the 
PlantPAx system to make sure that you buy the proper components.

• Install - Provides direction on how to implement the PlantPAx system 
architecture to help develop your application. 

• Prep - Provides guidance on how to get started and learn the best 
practices for developing your application. 

• Develop - Contains the application-specific libraries and objects that 
are used to construct your application that resides on the PlantPAx 
architecture.

• Operate – Provides guidance on how to verify and maintain your 
systems for operation of your plant.

Summary of Changes This publication contains the following new or updated information. This list 
includes substantive updates only and is not intended to reflect all changes.

Purpose of this Manual

Virtualization is the abstracting of the operating system from the hardware to 
enable running multiple virtual machines on one piece of hardware. This 
manual shows how to use templates to configure virtualized system elements.

Virtual image templates are provided for the following PlantPAx system 
elements:

• Process Automation System Server (PASS) 
• Engineering Workstation (EWS) 
• Operator Workstation (OWS) 
• SQL Server - AppServ-Info (SQL)
• Process Automation Domain Controller (PADC)
• Historian Server - AppServ-Info (Historian)
• Batch Management Server - AppServ-Batch 
• Asset Management Server - AppServ-Asset 
• Operator Workstation Application Server - AppServ-OWS 

Topic Page
Configure System Software section updated for clarity. 102
Configure the FactoryTalk Directory section updated for clarity. 116
Install VantagePoint Server Software section updated for clarity. 124
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• Engineer Workstation Application Server - AppServ-EWS 
• VantagePoint® Server - AppServ-Info (VantagePoint)

In addition to these virtual templates, this manual has deployment 
instructions for the consolidated PASS (PASS-C) and associated OWS (OWS 
ISO). The PASS-C and OWS ISO are designed to deploy on a physical machine.

Before you Begin

Obtain PlantPAx virtual image templates, PASS-C, and OWS ISO USB devices 
by the following methods:

• Media - Order a physical copy of the virtual image template. End user is 
responsible for the proper Microsoft® licensing.

• Electronic Software Delivery (ESD) - Download an electronic copy of 
the virtual image template from the Product Compatibility and 
Download Center (PCDC) website. When you download the PASS-C or 
OWS ISO, you receive an ISO file that you can use to create a bootable 
device.

Virtual servers require Microsoft OS License Keys for Windows Server 
operating systems. 

Virtual workstations require a Microsoft OS License Key for Windows 
operating systems.

FactoryTalk Activation Certificates contain serial numbers and product keys 
for the Rockwell Automation products that correspond to the templates.

See PlantPAx Virtual Image Template Catalog Numbers on page 9

A domain controller is recommended to be configured and accessible on the 
network. 

vSphere Web Client is used to deploy virtual machines. 

vCenter server is optional and enables you to create your own virtual image 
templates and increase your ability to manage a virtualized control system.

IMPORTANT Our templates can be used with any virtualization software. We use 
VMware for the procedures in this document.

Tip: Remote Desktop Services uses its own method of licensing clients that log 
on to Remote Desktop Services servers. This method is separate from licensing 
for the Windows Server family of operating systems. Therefore, AppServ-OWS 
and AppServ-EWS Remote Desktop Connections must receive a valid license. 
This license is issued by a Remote Desktop Licensing Server before they can log 
on to a Remote Desktop Session Host or Connection Broker.
For licensing of these components, contact your Microsoft distributor.

IMPORTANT If you already own individual product activations, these activations 
can also be used to activate the virtual image templates.
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Microsoft Operating System 
Software Licensing

Each server or workstation instance that is deployed from a template, bootable 
device, or ISO needs its own Microsoft operating system license and Rockwell 
Automation® software licenses.

The end user is responsible for properly licensing a Microsoft OS for each 
template deployed. Additional licenses can be purchased from your Microsoft 
distributor.

PlantPAx Virtual Image 
Template Catalog Numbers

Build Details PlantPAx Virtual Image Template

Virtual Template Cat. No. Description

PASS 9528-PASSVTENM
USB device contains the virtual image template for the PASS. The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-installed but not 
activated. 

EWS 9528-EWSVTENM
USB device contains the virtual image template for the engineering workstation. The end user is responsible for 
acquiring the appropriate Microsoft OS license for Windows 10. All required Rockwell Automation software is pre-
installed but not activated.

OWS 9528-OWSVTENM
USB device contains the virtual image template for the OWS. The end use is responsible for acquiring the 
appropriate Microsoft OS license for Windows 10. All required Rockwell Automation software is pre-installed but not 
activated.

AppServ-OWS, AppServ-
EWS 9528-APPXWSENM

USB device contains the virtual image template for AppServ-OWS and AppServ-EWS. The end user is responsible for 
acquiring the appropriate Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-
installed but not activated. You must also purchase the appropriate Windows CAL from a Microsoft distributor.
IMPORTANT: Each client needs an RDS CAL license.

AppServ-Info (Historian) 9528-APPHISENM
USB device contains the virtual image template for AppServ-Info (Historian). The end user is responsible for 
acquiring the appropriate Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-
installed but not activated.

AppServ-Asset 9528-APPASMENM
USB device contains the virtual image template for AppServ-Asset. The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. All required Rockwell Automation software is pre-installed but not 
activated.

AppServ-Info (SQL) 9528-APPSQLENM USB device contains the virtual image template for AppServ-Info (SQL). The end user is responsible for acquiring 
both the appropriate Microsoft OS license for Server 2016 and Microsoft SQL server. 

AppServ-Info 
(VantagePoint) 9528-APPVTPENM

USB device contains the virtual image template for AppServ-Info (VantagePoint). The end user is responsible for 
acquiring the appropriate Microsoft OS license for Server 2016. Most required Rockwell Automation software is pre-
installed but not activated. The FactoryTalk VantagePoint software is not pre-installed for your convenience. 

AppServ-Batch 9528-APPBATENM
USB device contains the virtual image template for AppServ-Batch. The end user is responsible for acquiring the 
appropriate Microsoft OS license for Server 2016. Most required Rockwell Automation software is pre-installed but 
not activated. The FactoryTalk Batch software is not pre-installed.

Domain controller 9528-PADCVTENM
USB device contains the virtual image template for a Domain controller. The end user is responsible for acquiring 
the appropriate Microsoft OS license for Server 2016. You must also purchase the appropriate Windows CAL from a 
Microsoft distributor.

System Element Cat. No. Description

PASS - C (Consolidated) 9528-PASSCENM
USB device contains a bootable image to install a consolidated PASS on a physical machine. The consolidated 
PASS includes Historian, VantagePoint, Asset Management, OWS, and EWS. The end user is responsible for 
acquiring the appropriate Microsoft OS license for Server 2016. A Rockwell Automation license is required for 
software activation.

OWS ISO 9528-OWSISOENM
USB device contains a bootable image to install an operator workstation on a physical machine. The end user is 
responsible for acquiring the appropriate Microsoft OS license for the Windows 10 operating system. A Rockwell 
Automation license is required for software activation.
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Element Category Description

Process Automation 
System Server (PASS)

Operating system Microsoft Windows Server 2016 Standard 

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services platform software, version 6.20.00
– FactoryTalk Activation Manager software, version 4.04.14
– FactoryTalk Linx software, version 6.20.00

• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk View Site Edition Server software, version 12.00.00
• FactoryTalk View Studio Enterprise software, version 12.00.00
• FactoryTalk Alarm and Events software, version 6.20.00
• FactoryTalk Diagnostics software, version 6.20.00
• FactoryTalk Historian SE Live Data Interface, version 7.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Engineering 
Workstation (EWS)

Operating system Microsoft Windows 10 Enterprise LTSC 2019

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx® Classic software, version 4.20.00
– FactoryTalk Activation Manager software, version 4.04.14

• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk View Site Edition Server software, version 12.00.00
• FactoryTalk View Studio Enterprise software, version 12.00.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk Diagnostics software, version 6.20.00
• RSLogix 5000® Professional software, versions 20.05.00 
• Studio 5000 Logix Designer® application, versions 33.00.00, 32.03.00, 31.02.00, 30.02.00, 

28.03.00, 24.02.00, 21.03.02
• Studio 5000 Application Code Manager, version 4.00.00
• RSNetWorx™

– RSNetWorx for EtherNet/IP™ software, version 28.01.00
– RSNetWorx for ControlNet® software, version 28.01.00
– RSNetWorx for DeviceNet® software, version 28.01.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Client software, version 10.00.00

• FactoryTalk Historian SE Management Tools, version 7.00.00
• Studio 5000® Logix Emulate™, version 33.00.00
• ControlFLASH Plus™ software, version 3.01.00
• ControlFLASH™ software, version 15.03.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Additional third-party software • Microsoft SQL Server 2012 SP4 Management Tools
• Microsoft SQL Server 2012 SP4 Client Connectivity

Operator Workstation 
(OWS)

Operating system Microsoft Windows 10 Enterprise LTSC 2019

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00
– FactoryTalk Activation Manager software, version 4.04.14

• FactoryTalk Diagnostics software, version 6.20.00
• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk AssetCentre Client software, version 10.00.000
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Process Automation 
Domain Controller 
(PADC)

Operating system Microsoft Windows Server 2016 Standard
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Application Server 
OWS (AppServ-OWS)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00
– FactoryTalk Activation Manager software, version 4.04.14

• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk Diagnostics software, version 6.20.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk AssetCentre Client software, version 10.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Application Server 
EWS (AppServ-EWS)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00
– FactoryTalk Activation Manager software, version 4.04.14

FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk View Site Edition Server software, version 12.00.00
• FactoryTalk View Studio Enterprise software, version 12.00.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk Diagnostics software, version 6.20.00
• RSLogix 5000® Professional software, versions 20.05.00 
• Studio 5000 Logix Designer® application, versions 33.00.00, 32.03.00, 31.02.00, 30.02.00, 

28.03.00, 24.02.00, 21.03.02
• Studio 5000 Application Code Manager, version 4.00.00
• RSNetWorx

– RSNetWorx for EtherNet/IP software, version 28.01.00
– RSNetWorx for ControlNet software, version 28.01.00
– RSNetWorx for DeviceNet software, version 28.01.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Client software, version 10.00.00

• FactoryTalk Historian SE Management Tools Suite, version 7.00.00
• Studio 5000 Logix Emulate, version 33.00.00
• ControlFLASH Plus software, version 3.01.00
• ControlFLASH software, version 15.03.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Additional third-party software • Microsoft SQL Server 2012 SP4 Management Tools
• Microsoft SQL Server 2012 SP4 Client Connectivity

Application Server 
Historian (AppServ-
Info Historian)

Operating system Microsoft Windows Server 2016 Standard 

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Activation Manager software, version 4.04.14
– FactoryTalk Diagnostics software, version 6.20.00

• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk Historian Site Edition Server, version 7.00.00
• FactoryTalk Historian ActiveView software, version 7.00.00
• FactoryTalk Historian DataLink software, version 7.00.00
• FactoryTalk Historian Management software, version 7.00.00
• FactoryTalk Historian ProcessBook software, version 7.00.00
• FactoryTalk Historian SE Live Data Interface, version 7.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13
• FactoryTalk Linx software, version 6.20.00

Element Category Description
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Application Server 
Asset Management 
(AppServ-Asset)

Operating system Microsoft Windows Server 2016 Standard 

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 6.20.00
– FactoryTalk Diagnostics software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00
– FactoryTalk Activation Manager software, version 4.04.14
– FactoryTalk Alarm and Event software, version 6.20.00

• FactoryTalk AssetCentre
– FactoryTalk AssetCentre Server software, version 10.00.00
– FactoryTalk Asset Centre Client software, version 10.00.00

• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Additional third-party software Microsoft SQL Server Express 2016 SP2 Advanced (includes Management Studio)

Application Server 
Information SQL 
(AppServ-Info-SQL)

Operating system Microsoft Windows Server 2016 Standard

Microsoft SQL Server Standard 2016 (includes 
Management Studio) Microsoft SQL Server Standard 2012 SP4 (includes Management Studio)

Application Server 
Information 
VantagePoint® 
(AppServ-Info-
VantagePoint)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services Platform software, version 3.00.00
– FactoryTalk Activation Manager software, version 4.02.00
– FactoryTalk Diagnostics software, version 3.00.00
– FactoryTalk Linx software, version 6.00.00

• FactoryTalk VantagePointSystem Server software, version 8.10.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.10

Application Server 
Batch Management 
(AppServ-Batch)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Activation Manager software, version 4.04.14
– FactoryTalk Diagnostics software, version 6.20.00
– FactoryTalk Services Platform software, version 6.20.00
– RSLinx Classic software, version 4.20.00

• FactoryTalk Batch, version 14.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13

Element Category Description
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USB Devices
Element Category Description

PASS-C 
(consolidated)

Operating system Microsoft Windows Server 2016 Standard

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services platform software, version 6.20.00
– FactoryTalk Activation manager software, version 4.04.14
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00

• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk View Site Edition Server software, version 21.00.00
• FactoryTalk View Studio Enterprise software, version 12.00.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk Diagnostics software, version 6.20.00
• FactoryTalk Historian SE Live Data Interface, version 7.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13
• FactoryTalk Historian SE software, version 7.00.00
• FactoryTalk AssetCentre Server, version 10.00.00
• FactoryTalk AssetCentre Client, version 10.00.00
• RSLogix 5000 Professional software, versions 20.05.00 
• Studio 5000 Logix Designer application, versions 33.00.00, 32.03.00, 31.02.00, 30.02.00, 

28.03.00, 24.02.00, 21.03.02
• Studio 5000 Application Code Manager, version 4.01.00
• ControlFLASH software, version 15.03.00
• ControlFLASH Plus software, version 3.01.00

Additional software SQL Server Express 2016

Operator Workstation 
(OWS ISO)

Operating system Microsoft Windows 10 Enterprise LTSC 2019

Rockwell Automation software

• FactoryTalk Services Platform
– FactoryTalk Services platform software, version 6.20.00
– FactoryTalk Linx software, version 6.20.00
– RSLinx Classic software, version 4.20.00
– FactoryTalk Activation manager software, version 4.04.14

• FactoryTalk Diagnostics software, version 6.20.00
• FactoryTalk View Site Edition Client software, version 12.00.00
• FactoryTalk Alarm and Event software, version 6.20.00
• FactoryTalk AssetCentre Client, version 10.00.00
• Rockwell Automation Windows Firewall Configuration Utility, version 1.00.13
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Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation.

You can view or download publications at rok.auto/literature.

Resource Description

EtherNet/IP Network Devices User Manual, ENET-UM006 Describes how to configure and use EtherNet/IP devices to communicate on the EtherNet/IP 
network.

Ethernet Reference Manual, ENET-RM002 Describes basic Ethernet concepts, infrastructure components, and infrastructure features.

System Security Design Guidelines Reference Manual, SECURE-RM001
Provides guidance on how to conduct security assessments, implement Rockwell Automation 
products in a secure system, harden the control system, manage user access, and dispose of 
equipment. 

Industrial Components Preventive Maintenance, Enclosures, and Contact Ratings 
Specifications, publication IC-TD002 Provides a quick reference tool for Allen-Bradley industrial automation controls and assemblies.

Safety Guidelines for the Application, Installation, and Maintenance of Solid-state 
Control, publication SGI-1.1

Designed to harmonize with NEMA Standards Publication No. ICS 1.1-1987 and provides general 
guidelines for the application, installation, and maintenance of solid-state control in the form of 
individual devices or packaged assemblies incorporating solid-state components.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell Automation industrial system.
Product Certifications website, rok.auto/certifications. Provides declarations of conformity, certificates, and other certification details.
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Chapter 1

Basics of Virtualization

Virtual Image Templates Rockwell Automation offers virtual image templates as an option to deploy a 
virtualized PlantPAx® system. The PlantPAx Virtual Image Templates deliver 
all system elements as pre-installed, drop-in virtual machines. The industry 
also refers to virtualized system elements as virtual appliances. However, in 
this manual, virtual system elements are referred to as virtual image templates 
because you can use them to deploy as many virtual appliances as you want.

The virtual image templates are 
delivered as an Open Virtual 
Appliance (OVA) file on USB devices 
or via the Web. With OVA files, you 
can use any virtualization platform 
for deployment. The guidelines that 
are contained in this manual are for 
setup and deployment of the 
templates in a VMware vSphere 
environment.

The virtual image templates help to reduce validation costs and initial 
engineering time, enhance scalability, simplify upgrades, and patch 
management. Only one copy of the virtual image templates is needed for a 
project. 

Some of the benefits of a virtualized PlantPAx system include the following:

• Increased energy savings
• Extended system life
• Reduced system footprint and hardware cost
• Increased up time and availability
• Self-contained simulation and engineering
• Faster server provisioning
• Improved disaster recovery

Flexibility and ease of deployment are key when designing a virtual 
infrastructure. Both intangibles are a part of the PlantPAx system. 

Virtual

Hypervisor

vSphere Web
Host
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Chapter 1          Basics of Virtualization
Choose a Hypervisor

A hypervisor is computer software that manages a physical host server and 
allocates computing resources to run multiple guest operating systems. Each 
guest is a virtual machine (VM) that runs in the host server with its own 
memory, storage, and CPU allocation on the host.

Depending on the make and model of your host server, the hypervisor 
installation files are available directly from the manufacturer's website. These 
custom downloadable packages often contain drivers for specialized 
hardware. If a customized download is not available from the vendor, you can 
download the hypervisor directly from the VMware website.

1. Log in to the vendor or VMware website.
2. Find the support or downloads section and search for hypervisors.
3. Select the latest version of hypervisor that is supported on your server 

hardware or choose the version of which you have licensing.
4. Download the hypervisor.

Install a Hypervisor This section describes how to install the VMware vSphere ESXi hypervisor to a 
host server. To install the hypervisor on your server, we recommend that you 
copy the installer image (.iso) to a DVD. If desired, you can also copy the 
installer image (.iso) to a USB drive (at least 1 GB).

Copy Installer Image to DVD
1. Right-click the downloaded installer image and choose Burn disk image.

IMPORTANT The following procedures apply only to virtual templates. Skip to Chapter 6 if you are 
deploying a PASS-C or OWS ISO

IMPORTANT Rockwell Automation recommends and tests on VMware 
hypervisors. Other hypervisors are available; however, we describe 
using PlantPAx image templates on the VMware vSphere ESXi 
hypervisor.
For a production environment, we recommend a minimum of a 
VMware vSphere Essentials Kit. The vSphere Essentials Kit supports 
6 CPUs and a vCenter server access to key virtual components at a 
minimum cost.
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Chapter 1          Basics of Virtualization
2. Select the DVD drive where you will write the data, and select Burn. 
Select Close when the DVD is completed.

Copy Installer Image to USB Drive

1. Right-click the downloaded installer image and choose copy.
2. Select a location on the USB drive, right-click, and choose paste.
3. When the file copy is completed, you can remove the USB drive.

Use a DVD or USB Drive to Start Server

When you start the server, make sure to choose the DVD or USB drive that 
contains the installer image as the booting address. Complete these steps to 
install the ESXi (hypervisor).

1. Insert the DVD or USB drive into the host physical server.
2. Select the optional booting address during the server startup.

3. Press Enter to continue'.

IMPORTANT Before starting this procedure, make sure that the USB drive has 
enough space on it to hold the hypervisor 'ISO' file.
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Chapter 1          Basics of Virtualization
4. On the End User License Agreement (EULA) page, read the EULA, and 
press F11 to accept the terms of the EULA and continue.

5. Select the disk where you will install the vSphere Hypervisor and press 
Enter to continue.

6. Select the desired keyboard and press Enter to continue.

7. Type a root password, retype the password, and press Enter to continue.

IMPORTANT Remember this password; you use it again in future steps.
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Chapter 1          Basics of Virtualization
8. Press F11 to Install.

9. Remove the DVD or USB device and press Enter to shut down and 
restart. The server shutdown takes a few minutes.

Assign an IP Address to the Host

You must assign an IP address to the host so that it is on the desired network 
and can communicate with the client workstations. For example, you can 
deploy a virtual image template in this server remotely from another 
workstation on the same network.

1. After the system restarts, press F2 to Customize System/View Logs.

For the displays in this section, use the arrow keys on your keyboard to move 
between the fields on the pages.
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Chapter 1          Basics of Virtualization
2. Enter the Login name and password that was created in Use a DVD or 
USB Drive to Start Server.

3. Select 'Configure Management: Network.'

4. Select 'IPv4 Configuration.’

5. Select 'Set static IP address and network configuration' and press the 
Space bar. (The presence of a small circle between the parentheses 
indicates that this option is selected.) Select the IP address, Subnet Mask, 
and default gateway address and enter the appropriate values for your 
system and organization.
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Chapter 1          Basics of Virtualization
6. On the Configuration Management Network page, press <Esc> to Exit. A 
message appears to confirm that you want to change the management 
network of the host. Select Yes.

7. On the System Customization screen, press <Esc> to log out. You have 
assigned an IP address to the host server.

Using a vSphere Web Client 1. Open a web browser and type the IP address that you created for the 
hypervisor host. A security warning appears the first time that you 
connect to the ESXi host server.

2. Select Advanced.
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3. The security warning expands with an invalid certificate message. Select 
Add Exception.

4. Contact your IT department if you want a security certificate for your 
ESXi host server. To ignore the warning, select Confirm Security 
Exception.

5. Log in to the VMware ESXi Host using the credentials created in Use a 
DVD or USB Drive to Start Server. (The default user name is ‘root’.)

6. Select Navigator.
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7. Select Manage, Licensing, Actions, and Assign License.

8. Enter the license key and Check Licenses.

9. Select Assign License. After it is assigned, a list of features that are 
associated with the license is displayed.
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Notes:
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Chapter 2

Deploy PlantPAx Virtual Machines

Distributed control systems are composed of several industry-accepted system 
elements. Virtual Image Templates are virtualized system elements, which 
contain the software and tools that comprise a specific system element. The 
templates are a framework to deploy the necessary system elements for a 
PlantPAx® system in a virtual environment conveniently and consistently.

This chapter describes how to deploy PlantPAx image templates to create 
virtual machines and how to configure the initial settings when powering up 
for the first time.

A virtual machine acts independently and has its own resource allocation from 
the host. You interact with virtual machines as if they are on a dedicated 
workstation with their own physical resources.

Deploy PlantPAx Virtual 
Image from OVA file

This section describes the first-time deployment of a PlantPAx virtual image. 
The virtual image can be deployed from a purchased USB drive or from a web 
download stored locally on a workstation.

The workstation would be the same computer where you are using the vSphere 
Web Client to connect to the host server. 

This deployment procedure is applicable to all PlantPAx virtual templates, and 
is required every time a virtual image template is deployed for the first time 
into your system.

TIP: If the virtual image template is sourced from a USB drive, we advise you to 
copy the files to your workstation and use the copies to speed the deployment 
process.

IMPORTANT If you plan to deploy a domain controller, it is recommended that the 
domain controller is the first element that is deployed in the system. 
The PADC template facilitates future activities, such as creating your 
own virtual image templates and deploying virtual images to your 
system at your convenience.
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Chapter 2          Deploy PlantPAx Virtual Machines
1. Open a web browser and enter the IP address that you created for the
host server. Enter the user name and password for the EXSi host, and 
Select Log in

2. In the Navigator pane, select Virtual Machines and choose
Create/Register VM.

3. Select ‘Deploy a virtual machine from an OVF or OVA file’.
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4. Enter a name for the virtual machine.
Click in the shaded area and select the .ova file to be used. 
The virtual file displays with the name.

5. Select the datastore for your configuration and disk files storage..

6. Use defaults for network mapping and disk provisioning, and select 
‘Power on automatically.’

IMPORTANT There are two main formats for storing virtual images: OVF (open 
virtual format) and OVA (open virtual appliance). Our templates are 
for appliances, which are self-contained virtual system elements. 
VMware software labels the wizard ‘OVF Template’ but ignore 
because your PlantPAx Virtual Image Templates in the OVA format 
are suitable for this procedure.
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7. Select Finish to upload the virtual template.

The completion percentage is shown at the bottom.

The Result column shows ‘Completed successfully’ when the template 
upload finishes.
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Power On the Virtual Machine
1. Open a web browser and enter the IP address that you created for the

host server. Enter the user name and password for the EXSi host, and 
Select Log in

2. Right-click the Virtual Machine and choose Power>Power on.

Windows Out of Box Experience

The Windows Out of Box Experience (OOBE) consists of displays that require 
customers to accept the end users license agreement (EuLA), connect to the 
internet, log in with or sign up for a Microsoft® Account, and share 
information with the OEM.

IMPORTANT When powering on the virtual machine for the first time, the screen 
can remain black for several minutes.
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Chapter 2          Deploy PlantPAx Virtual Machines
Complete these steps for the initial configuration of all virtual machines that 
were deployed using PlantPAx image templates.

Windows Server 2016 virtual machines require the OOBE following 
initialization:

1. Choose the appropriate location, language, and keyboard settings and 
Next.

2. Enter the product key to activate windows or choose to activate later.
3. On the EULA dialog box, read the license terms and Accept.
4. Type a password for Administrator, retype the password to verify, and 

Finish.

Windows 10 LTSC virtual machines require the following OOBE initialization:
1. Click ‘Skip for now’ for an internet connection.
2. On the EULA dialog box, read the license terms and Accept.
3. Type a user name and Next
4. Create a password, retype password to verify, and Finish.
5. Create security questions, and Next.
6. Click No when prompted to make Cortana your personal assistant.
7. Turn off all privacy settings for your device and Accept.
8. Enter the Windows product key.

Initial Windows Login

A logon message appears, which prompts you to press Ctrl + Alt + Delete key 
combination to unlock'. 

1. DO NOT press Ctrl + Alt + Delete for a virtual machine.
2. Instead press Ctrl + Alt + Insert. this is the VMware key combination to 

unlock.
3. Type the Administrator password that you created and Press Enter.

If you see the Other-User logon, type 'Administrator', type the administrator 
password that you created and Press Enter. Wait until you see the network 
message in the following steps.

1. Select 'Yes' to allow the PC to be discoverable.

If you skipped the product key earlier, another dialog window appears to 
remind you that Windows must be activated.

2. In the Product Key window, enter a valid Windows Product Key.
3. Verify that the product key is correct.
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4. Select OK in the message window when the product key was installed 
successfully.

5. Select OK in the activation window.
6. Activate the key with a KMS server; your company’s or Microsoft’s. See 

Appendix A for more licensing information.

VMware Tools

The VMware vSphere Client software has better graphic performance with the 
VMware Tools SVGA driver installed. The VMware Tools package also supports 
required shared folders and drag-and-drop features.

Other tools in the package support synchronization of time in the guest 
operating system, copy and paste between guest and host, and improved 
mouse performance in some guest operating systems.

Complete these steps to install or upgrade VMware tools on the VMware
Virtual Machine.

1. Open a web browser and type the IP address that you created for the
host server.

2. Enter the user name and password for the local host, and click Log in.
3. From the Navigator in the left pane, right-click the virtual machine in 

which you want to update or install VMware Tools. Select Guest OS and 
choose Install VMware Tools.

4. Open Windows Explorer on the virtual machine image that you want to 
install VMware Tools.

IMPORTANT Images that are shown in this section are VMware vSphere software, 
version 6.5.

IMPORTANT The guest OS of the virtual machine must be running.
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5. Select ‘This PC’ to view the tools to install on Drive D.

6. Double-click the DVD drive to initiate the install.
7. When the VMware Tools Setup Welcome window appears, select Next

to start the setup wizard.

If you are using the free version of VMware ESXi hypervisor, which doesn't 
include a vCenter server, then you can skip chapter 3 and proceed to chapter 4 
to continue with Windows server configuration.

Display Action
Choose Setup Type Select Complete
Ready to Install VMware Tools Select Install
Completed VMware Tools Setup Wizard Select Finish
VMware Tools Setup Restart Select YES
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Chapter 3

VMware ESXi vCenter Server 

A VMware vCenter server is an optional component that allows for centralized 
management of your virtual infrastructure. You can manage multiple hosts 
servers and access all VMs from one vSphere Web Client.

While a vCenter server may not be needed with small systems, it is highly 
recommended and required with large systems. Following are some of the key 
features that a vCenter server provides:

• Single sign-in authentication (Domain controller required)
• Access multiple hosts, all VMs, datastores, and networks from one 

console
• Organize inventory objects such as hosts, folders, and clusters into 

datacenters
• Create templates for future virtual machine deployments
• Clone existing VMs, even when powered on
• Migrate VMs between hosts and datastores
• View alerts and notifications that are required to help prevent or remedy 

the emerging issues

Install a vCenter Server There are two installation types for a vCenter server. 
• vCenter Server for Windows software runs on a Microsoft® Windows 

server operating system. This Windows OS can run on a physical 
computer or as a virtual machine on a host server.

• vCenter Server Appliance (vCSA) runs as a virtual machine based on 
SUSE Linux Enterprise Server 64-bit and comes as an OVF appliance 
ready for use.

There are differences in scalability (number of hosts and VMs), database 
options, performance, and security in each vCenter server type. Determine 
which option best fits your environment before implementing a vCenter server 
for infrastructure. This section shows how to install a vCenter Server 
Appliance.

Perform these steps on the workstation you use to manage your virtual 
appliances (templates and machines).

IMPORTANT A vCenter server can contain multiple datacenters. Larger 
organizations can use multiple datacenters to represent 
organizational units in their enterprise. Inventory objects can 
interact within datacenters, but interaction across datacenters is 
limited. For example, you can move a virtual machine with vMotion 
technology across hosts within a DataCenter but not to a host in 
another DataCenter.
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1. On the VMware website, download the vCenter Server Appliance 6.5 
software and mount the .iso image.

2. Start the vCenter Server Appliance 6.5 installer. Choose vCenter Server 
6.5 appliance>vcsa-ui-installer>win32>installer.exe.

3. Select Install. The install wizard opens.

Wizard Page Action
Introduction Select Stage 1. Deploy appliance.
End User License Agreement Check I accept the terms of the license agreement 

Select Deployment Type Select vCenter Server with an Embedded Platform Services 
Controller 

Appliance Deployment Target Enter the ESXi host information of the location where the vCenter 
server appliance is deployed, and enter the host credentials.

Certificate Warning Select YES
Set up appliance VM Enter the name for the appliance and set the root password. 
Select deployment size Select the deployment size for your environment. 
Select datastore Select the datastore where the VCSA appliance is stored. 

Configure network settings Configure the networking for the VCSA appliance. Put the IP address 
that is used in both the DNS forward and reverse lookup zones.

Ready to complete stage 1 Verify that the configuration is correct on the summary dialog box.
Install Stage 1 Deployment Complete Select continue to proceed to stage 2 setup
Stage 2 Introduction Select Next
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Create a DataCenter A DataCenter is the primary container of inventory objects such as hosts and 
virtual machines.

With the creation of the DataCenter, we show you how to make a copy of a 
virtual image and turn it into a template for future deployments.

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed.

2. Click vSphere Web Client (Flash).

Appliance Configuration Set the Time Synchronization mode. Enable SSH Access.
SSO Configuration Enter a domain name, password, and site name. 

Configure CEIP Check to participate in the Customer Experience Improvement 
Program (CEIP) if interested.

Ready to complete Verify that the configuration is correct on the summary dialog box.

Wizard Page Action

IMPORTANT The images that are shown in this section are VMware vSphere Client 
software, version 6.5.
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3. Enter the Username and Password. Use the User name and password 
that you created for the vCenter Server.

The DataCenter is the primary container of inventory objects such as hosts and 
virtual machines. 

4. From The VMware vSphere Web Client dialog box, highlight your 
vCenter Server, and click 'Create DataCenter'. 

IMPORTANT The user name consists of the vCenter Single Sign-On user name 
plus '@' plus the Domain name.
In our example, the user name is 
'administrator@system.plantpax.local'.
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5. When prompted, type a name for the new DataCenter (‘New DataCenter’ 
in our example) and click OK.

Add a Host

The host is the physical server where the virtual image is to be deployed. 

1. The New DataCenter is added under the vCenter Server. Highlight the 
New DataCenter and select 'Add a Host' to add a host server. The add 
host wizard starts.

Wizard Page Action
Name and Location Enter the Host IP address
Connection Settings Enter the Username and Password
Host Summary Verify the settings
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2. The Host is added under the DataCenter. The Navigator section of the 
vSphere Web Client window now includes the vCenter server 
(VRTXvCenter), the DataCenter (New DataCenter), and the Host 
(172.18.1.13) as shown in the following image.

Assign a license

• If you use the trial license that came with the VMware vSphere Hypervisor, select the default Evaluation License
• If you have purchased a permanent license, Select the Plus Sign to assign a new license key to this host. Enter the license key.

Lockdown Mode Select Disabled

VM location
Select the DataCenter that you created.
IMPORTANT: Because a vCenter server can manage multiple host servers, make sure to create/select the proper DataCenter and host server where the 
virtual machines reside. 
These organizational features help improve your understanding of your infrastructure and help with the management of servers.

Ready to complete Verify that the configuration is correct.

Wizard Page Action
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Create a Template

This section shows how to create your own templates. These templates can be 
based off the original PlantPAx® virtual image template and customized into 
your own templates.

Start with an existing virtual machine. This VM may receive changes such as 
additional software, security patches, and configurations that you plan on 
reusing throughout your infrastructure. When you are finished modifying the 
VM, it is cloned, and a template is created.

This template can be used to deploy other images. You can store the original 
template for safekeeping in case you modify your templates. 

1. Right-click the virtual image that you want to clone and choose 
Clone>Clone to Template to open the wizard.

To help prevent VMs from containing duplicate system identifiers, it is 
recommended to run Windows SYSPREP on the operating system before 
creating a template. 

Wizard Page Action
Select a name and folder Enter a name for the new template and select a location
Select a compute resource Select a host location to store the new template

Select storage

Select the disk format, storage policy, and the hypervisor that manages the resources of the server that hosts this template. 

Disk Format Options:
• Same format as source - Use the same format as the original disks.
• Thick Provision Lazy Zeroed - Disk storage is allocated immediately in a default thick format. Blocks containing older data on the 

storage device are cleared only when the virtual machine writes new data to the disk for the first time.
• Thick Provision Eager Zeroed - Disk storage is allocated immediately in a default thick format where blocks on the physical storage 

device are formatted with zeros to overwrite any older data.
• Thin Provision - Disk storage is allocated on demand as data is written to virtual disks.

Ready to complete
Verify that the configuration is correct.
IMPORTANT: The process of cloning a virtual machine to a template can take up to 30 minutes. This time is largely dependent on the 
size of the hard disk drive of the virtual machine you are making a template from.

TIP: Consider the clone to virtual machine option as a manual method to back up 
fully configured and running virtual machines. The cloned image can be stored 
on a local or remote VMF5 datastore, or a remote datastore on a Windows server 
featuring network file storage (NFS) capability.
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Deploy Your Own Template When you have virtual image templates that are loaded into your DataCenter, 
you can deploy any number of virtual images from those templates. Additional 
deployments can be performed from these new templates. 

1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed.

2. Click vSphere Web Client (Flash).

3. Enter the Username and Password. Use the User name and password 
that you created for the vCenter Server.

4. From the left side of the vSphere Web Client window, highlight your 
vCenter Server, then select the 'VMs' tab. Select the 'VM Templates in 

IMPORTANT The user name consists of the vCenter Single Sign-On user name 
plus '@' plus the Domain name.
In our example, the user name is 
'administrator@system.plantpax.local'.
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Folders' tab, then right-click the template that you plan to deploy to a 
New Virtual Image. Select 'New VM from This Template'.

5. In the Name box, type a name for the virtual machine. In the Inventory 
Location box, select a location to store the new virtual machine.
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6. The 'Select storage' step appears.
• In the 'Select virtual disk format' box, select "Thin Provision'. 
• In the 'VM storage policy" box, select 'Datastore Default'.
• Select the Datastore to host the cloned template.

7. The 'Select clone options' step appears.
• Clear 'Customize the operating system'. We recommend that no 

Customization is done at this stage.
• Clear 'Customize this virtual machine's hardware (Experimental)'.
• Clear 'Power on virtual machine after creation'. 

Format Description
Same format as source Use the same format as the original disks.

Thick Provision Lazy Zeroed
Disk storage is allocated immediately in a default thick format. Blocks 
containing older data on the storage device are cleared only when the virtual 
machine writes new data to the disk for the first time.

Thick Provision Eager Zeroed
Disk storage is allocated immediately in a default thick format where blocks 
on the physical storage device are formatted with zeros to overwrite any 
older data.

Thin Provision Disk storage is allocated on demand as data is written to virtual disks.

IMPORTANT When you clone a virtual machine or deploy a virtual machine from 
a template, you can customize the guest operating system of the 
virtual machine. Customizing guest operating systems can help 
prevent conflicts if virtual machines with identical settings are 
deployed.
You can specify the customization settings when you launch the 
Guest Customization wizard during the cloning or deployment 
process
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8. The 'Ready to Complete' step appears. Select one of the following to verify 
settings:

• If there is incorrect information, click Back to correct the information.
• If the information is correct, click Finish.

9. You can view the status of the task by finding 'Clone virtual machine' in Recent 
Tasks at the bottom of the window. When the status = Completed, the cloning 
is finished. 

Optional Virtual Machine 
Interactions

To help expedite the use of your virtual machines, consider the following 
options:

• Initiate Automatic Startup on page 43
• Set Resource Pool Priority on page 47

Initiate Automatic Startup
1. In a Web Browser, enter the IP address of the computer where your 

vCenter Server is installed. This IP address was created in Assign an IP 
Address to the Host.

2. On the Welcome to VMware vSphere screen, click vSphere Web Client 
(Flash).

IMPORTANT The process of deploying a virtual machine from a template can 
take up to 30 minutes. The time that is required is largely dependent 
on the size of the hard disk drive of the template you are using to 
deploy a virtual machine.
Rockwell Automation Publication 9528-UM001I-EN-P - February 2021 43



Chapter 3          VMware ESXi vCenter Server
3. Enter the Username and Password. Use the User name and password 
that you created for the vCenter Server in Install a vCenter Server. Click 
Login.

4. Select the Host Server, then select the Configure Tab, then select VM 
Startup/Shutdown. On the VM Startup/Shutdown window, click 'Edit'.

IMPORTANT The user name consists of the vCenter Single Sign-On user name 
plus '@' plus the Domain name.
In our example, the user name is 
'administrator@system.plantpax.local'.
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5. Check 'Automatically start and stop virtual machines with the system'. 
Click the Up Arrow to move the desired Virtual Machine host server from 
the Manual Startup category up to the Automatic Startup category.

You can select additional images and click the Up Arrow or Down Arrow 
to determine the startup order as shown in the following image. A 
sequential number order appears.

6. When you are satisfied with the Startup order, click OK.
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7. The Virtual Machines are now configured for Automatic Startup as 
shown in the following screen capture.

IMPORTANT Following is the recommended startup order for the typical system 
elements of a virtual PlantPAx system.
1. Process Automation Domain Controller - PADC
2. SQL server - AppServ-Info (SQL)
3. Process Automation System Server - PASS
4. Engineering Workstation Application Server (AppServ-EWS)
5. Redundant Process Automation System Server - PASS
6. Batch Management Server (AppServ-Batch)
7. Operator Workstation Application Server (AppServ-OWS)
8. Historian server - AppServ-Info (Historian)
9. VantagePoint® server - AppServ-Info (VantagePoint)
10. Asset Management server (AppServ-Asset)
11. Level 3 devices and computers
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Send Commands to Host Server

You can also send shutdown and restart commands directly to the host server 
via the vSphere Web Client.

1. On the vSphere Web Client window, right-click a host server and choose 
either Shut Down or Reboot.

2. In the confirmation window, type a reason for the Shut Down or Reboot 
and click OK or Cancel.

Set Resource Pool Priority

You can set the priority of the resource allocation that your virtual machine requires 
from the host server. The allocation of CPU and memory resources depends on 
performance needs. A virtual machine can be grouped for High Performance, Normal 
Performance, or Low Performance depending on its performance needs.

IMPORTANT For more information and resource pool priority recommendations 
for servers and workstation, see Resource Pool Allocation in the 
PlantPAx System
Reference Manual, publication PROCES-RM001.
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1. In a Web Browser, enter the IP address of the computer where your 
vCenter Server is installed. This IP address was created in Assign an IP 
Address to the Host.

2. On the Welcome to VMware vSphere screen, click vSphere Web Client 
(Flash).

3. Enter the Username and Password. Use the User name and password 
that you created for the vCenter Server in Install a vCenter Server. Click 
Login.

IMPORTANT The user name consists of the vCenter Single Sign-On user name 
plus '@' plus the Domain name.
In our example, the user name is 
'administrator@system.plantpax.local'.
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4. Right-click a host server and choose New Resource Pool.

5. Type the priority in the Name text box. For example, High Performance. 
From the Shares pull-down menu, select 'High' for the CPU and Memory 
Resources categories.

6. Repeat step 1 through step 5 for each virtual machine depending if the 
priority is High Performance, Normal Performance, or Low 
Performance. 

The priority types appear in the tree for the host server.
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7. Drag-and-drop virtual machines to the Resource Pool that matches the 
needs and intended use. Settings for that resource pool are assigned.
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Common Windows Configuration

The PlantPAx® system servers and workstations (virtual machines) are built on 
Microsoft® Windows operating systems that require some basic configuration. 

Windows Server 2016 Standard virtual machines are as follows:

• Process Automation Domain Controller - PADC
• Process Automation System Server - PASS
• SQL Server - AppServ-Info (SQL)
• FactoryTalk® Historian Server - AppServ-Info (Historian)
• FactoryTalk Batch Management Server - AppServ-Batch
• FactoryTalk Asset Management Server - AppServ-Asset
• Operator Workstation Application Server - AppServ-OWS
• Engineer Workstation Application Server - AppServ-EWS
• FactoryTalk VantagePoint® Server - AppServ-Info (VantagePoint)

Microsoft Windows 10 Enterprise LTSC 2019 virtual machines are as follows:
• Operator Workstation - OWS
• Engineer Workstation - EWS

This chapter describes how to set up the new operating systems after the you 
power them on for the first time, complete the OOBE initializations and install 
VMware Tools.

Local Administrator User 
Accounts

The default administrator account is often disabled to harden the operating 
system. We suggest that you create an Administrator user account for each 
user that requires administrative privileges. This safeguards server corruption 
by restricting access to the default administrative account, and creates a 
backup of critical system information. Each user can be delegated a separate 
user account with password protection.

1. Navigate to the Control Panel. 
2. Select User Accounts. 
3. Select Manage another account. 
4. Select ‘Add a user account’ below the Administrator icon. 
5. Enter a name for the user that is being added, a password, retype the 

password for verification, and a hint to remind you of the password. 
6. Select Next, and then Finish on the next dialog box.

IMPORTANT If you plan to deploy a domain controller, we recommend that you 
configure the domain controller before any other system element. 
See publication PROCES-UM100.
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7. Select the user that you created. 
8. Select ‘Change the account type’.
9. On the next window, select Administrator and click ‘Change 

Account Type’.

10. Sign out of Windows.
11. Press Ctrl+Alt+Insert. 

12. Log in with the user that was created.

Toolbar for Programs Menu Newer Microsoft operating systems lack the traditional Start Menu that 
contains an easily navigated programs menu.

Create a traditional style program menu on the lower right side of the 
Windows task bar using the following steps.

When complete, select the double arrow symbol next to Programs on the 
task bar and launch a traditional programs menu.

1. Navigate to the Control Panel and choose File Explorer Options. 

IMPORTANT Even though ‘Press Ctrl + Alt + Delete …’ is displayed on the screen, 
you must press Ctrl + Alt + Insert to access the virtual machine. The 
sequence 'Ctrl + Alt + Del' is reserved for the terminal from where 
you connect to the server that hosts the virtual machine.
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2. On the View Tab, select ‘Show hidden files, folders, and drives’ and click 
OK.

3. Right-click on the main windows taskbar, select Toolbars>New Toolbar.
4. On the New Toolbar window, navigate to your Programs folder. 

C:\ProgramData\Microsoft\Windows\StartMenu\Programs
5. Click Select Folder.

The result is a custom menu with easy access to Rockwell Software 
conveniently located on the Windows taskbar. 

6. Before proceeding, click the Date/Time in the lower right-hand corner of 
the desktop. Verify that the Date and Time settings are correct.
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7. Turn off the ‘Set time automatically’ feature in the Date and Time 
settings.

Rename the Computer Complete these steps to rename the computer.

1. Select  from the windows menu to open the Server Manager.

2. On the Server Manager window, select Local Server and then click the 
computer name.

3. Select Change on the System Properties dialog box. 

4. Type a new computer name.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.
54 Rockwell Automation Publication 9528-UM001I-EN-P - February 2021



Chapter 4          Common Windows Configuration
5. Select a Domain or Workgroup and click OK.

6. Enter an administrator username and password.
7. Select OK when the welcome to domain window appears.
8. Restart the virtual machine for the changes to the settings to take effect.
9. Log in by using your domain credentials or the local user administration 

account previously created.

Verify Ethernet Network 
Adapter Settings

The PlantPAx DCS Configuration and Implementation User Manual, 
publication PROCES-UM100 contains configuration information procedures 
for Domain or Workgroup infrastructures, such as managing IP addresses and 
computer name resolution.

To help with stable communications, we recommend configuring the speed, 
duplex, and power management settings for the Ethernet adapter. 

1. Navigate to the Control Panel.
2. Select Network and Sharing Center.
3. In the Network and Sharing Center window, select Change Adapter 

Settings.

4. Right-click the Ethernet network connection and choose Properties. 
5. If asked, type your password and click Yes.

IMPORTANT We recommend that you restart your computer so that these 
changes take effect.

IMPORTANT The configuration parameters that are described in this section 
apply to typical network infrastructures recommended for PlantPAx 
systems. Note that speed/duplex settings vary depending upon the 
network switch configuration.
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6. In the Ethernet Properties dialog box, select Configure.

7. Choose the Advanced tab.
8. Select Speed and Duplex and then choose Auto Negotiation.

9. Select the Power Management tab.
10. Clear the ‘Allow the computer to turn off this device to save power’ 

checkbox.
11. Select OK.

Verify Remote Settings Complete these steps to configure remote settings for a virtual image to allow 
remote connections to this computer.

1. Right-click the Windows Start icon and choose System.
2. Select Remote settings.
3. In the Remote Assistance Section at the top of the window, verify that the 

checkbox to ‘Allow Remote Assistance connections to this computer’ is 
not checked.
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4. In the Remote Desktop Section, select the ‘Allow remote connections to 
this computer’ box.

5. Select OK.

Verify the Processor 
Scheduling Setting

Complete these steps to adjust processor scheduling for best performance in 
the Windows Server operating system.

1. Right-click the Windows Start icon and choose System.
2. Select the Advanced system settings.
3. Select Settings in the Performance section.
4. Choose the Advanced tab.
5. Select Background services in the Processor scheduling section to adjust 

for the best performance.
6. Select OK twice.
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Notes:
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Configure PlantPAx System Servers

PlantPAx® system servers are based on Windows Server operating systems. 
This chapter describes how to configure system-specific elements and basic 
Rockwell Software setups.

Virtual templates are available for the following PlantPAx server system 
elements:

• Process Automation Domain Controller - PADC
• Process Automation System Server - PASS
• SQL Server - AppServ-Info (SQL)
• FactoryTalk® Historian Server - AppServ-Info (Historian)
• FactoryTalk Batch Management Server - AppServ-Batch
• FactoryTalk Asset Management Server - AppServ-Asset
• Operator Workstation Application Server - AppServ-OWS
• Engineer Workstation Application Server - AppServ-EWS
• FactoryTalk VantagePoint® Server - AppServ-Info (VantagePoint)

The required Rockwell Automation® software for each virtual server is 
included and pre-installed in the virtual image templates, but not activated. 
See Software Product keys and Activations for activation procedures.

Configure the PADC Virtual 
Server 

A domain controller is a server that responds to security authentication 
requests (logging in, checking permissions, and so forth) within the Windows 
server domain. A domain grants you access to a number of network resources 
(such as applications and printers) with the use of one user name and 
password combination.

The PlantPAx system uses a domain controller to store user account 
information, authenticate users, enforce security policies and best networking 
practices such as automatic network address assignment. Domain 
authentication is recommended, whether it is an existing domain or a new 
one.

Before configuring the domain controller, complete the following tasks:
• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server.
• Common Windows Configuration

IMPORTANT If you plan to deploy a domain controller, we recommend that you 
configure the domain controller before any other system element.
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Once you have completed these tasks, see the PlantPAx DCS Configuration 
and Implementation User Manual, publication, PROCES-UM100, for domain 
controller configuration procedures, such as:

• Creating a primary domain controller
• Creating an additional domain controller
• Configuring domain controllers
• Creating roles, areas and users
• Configuring group policy management
• Configuring group policies
• PlantPAx user policy objects

Configure the PASS Virtual 
Server

The Process Automation System Server (PASS) hosts essential software 
components to run your system. The data, human-interface (HMI), and alarm 
servers reside in the PASS.

The PASS hosts the FactoryTalk Services Platform that provides a set of 
common services (such as diagnostic messages, health monitoring services, 
and access to real-time data).

Before configuring the PASS Server, complete the following tasks:
• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server.
• Common Windows Configuration

Once you have completed these tasks, see the PlantPAx DCS Configuration 
and Implementation User Manual, publication, PROCES-UM100, for PASS 
configuration procedures, such as:

• Configuring FactoryTalk components
• Configuring HMI, DATA, and ALARM servers
• Redundant PASS considerations
• Configuring runtime security

Configure the SQL Virtual 
Server 

The AppServ-Info (SQL) server is a database that is used to store Process data 
for FactoryTalk AssetCentre, FactoryTalk VantagePoint, FactoryTalk Batch, 
and FactoryTalk Historian Asset Framework (AF) software programs. FTLinx 
and FactoryTalk Alarm and Event server also use the SQL database.

Before configuring the server, complete the following tasks:
• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server.
• Common Windows Configuration

IMPORTANT Use this procedure if you are installing SQL Standard on this server 
and are either installing a separate Historian server or are not using 
a Historian server. If you install a standalone Historian Server with 
SQL Express, skip this section and proceed to Configure the 
Historian Virtual Server on page 70
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Complete SQL Server 2016 Installation
1. On the virtual image desktop, click the Programs icon and choose 

Microsoft® SQL Server 2016>Configuration Tools>Complete SQL
Server 2012 Installation. 

2. Click Yes to allow the changes to be made to the device.
3. An installation wizard to complete image of SQL Server 2016 appears. 

Complete the wizard as follows:

IMPORTANT If you install both an Historian and SQL server, Complete VMware 
ESXi vCenter Server on both servers before continuing with this 
procedure.

IMPORTANT For the remainder of the installation, default selections are shown 
and we do not recommend any changes. Some PlantPAx 
configurations require these default selections. We recommend 
accepting the defaults, prove the system, and make changes later. 
Corresponding notice is provided where exceptions to this 
configuration are considered for changing now. Otherwise, simply 
click Next on the following screen captures to complete the process.

Wizard Page Action
Setup Support Rules Select OK once the rules have passed.

Product Key • Select Specify a free edition and then select Evaluation from the pull-down menu for a 90-day trial.
• Select Enter the product key and type your key to license your software.

License Terms Read the license terms, and select ‘I accept the license terms’
Microsoft Update Accept Default
Complete Image Rules Select Next once the rules have passed
Select Prepared Features Select Complete a prepared instance of SQL Server 2016
Feature Review Review the features to be configured
Instance Configuration Select Default Instance
PolyBase Configuration Select Use this SQL Server as a standalone PolyBase-enabled Instance
Server Configuration Select Default
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Database Engine Configuration

• Select Mixed Mode
• Enter and confirm the password
• Select Add Current User

Analysis Services Configuration

Select Multidimensional and Data Mining Mode
Select Add Current User

Wizard Page Action
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Install Historian Asset 
Framework on SQL Server

Installation of FactoryTalk Historian Asset Framework (AF) software is 
required to take advantage of the capabilities. Where the AF software is 
installed depends upon whether a Historian Collective will be used and if a 
separate SQL server is used.

If you choose to use a Historian Collective, you cannot install AF software on 
either of the Historian servers. We recommend that you install FactoryTalk 
Historian Asset Framework (AF) software on a separate SQL server virtual 
machine. Instructions are included in the SQL server section (see page 102). 

If the AF software cannot be installed on the SQL server, see the FactoryTalk 
Historian SE Installation and Configuration Guide for more information on 
locating your Asset Framework Server. The guide is available on the Historian 
server at C:\Program Files (x86)\Common Files\Rockwell\Help.

The procedures in this section apply only if you plan to do the following:

• Use FactoryTalk Historian Asset Framework in your PlantPAx system
• Install Asset Framework Server on the SQL Server

FactoryTalk Historian SE installation media
1. Download the FactoryTalk Historian SE installation media. 
2. Copy the Historian installation files to the local hard disk drive on the 

virtual SQL server into the c:\Install Files\ directory.

Reporting Services Configuration Select Reporting Services Native Mode > Install and Configure
Feature Rules Select Next once the rules have passed
Complete Image Process Select Next once Complete
Complete Select Close to complete the wizard

Wizard Page Action

IMPORTANT If you are not installing Asset Framework on the SQL Server, not 
deploying a Historian server, or installing a standalone Historian or 
you can skip this section. Proceed to Add Local User to the SQL 
Server on page 68.

IMPORTANT The installation files are not included in the SQL Server template. The 
installation files for services platform are located in the Historian 
template in c:\install files\7.00.00\FTHistorian\SE-DVDDL. If 
Historian is already deployed on the network, access the installation 
files through the network. Otherwise, the Historian template can be 
downloaded from the Product Compatibility and Download Center 
(PCDC) at 
http://compatibility.rockwellautomation.com/Pages/home.aspx.
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This installation is a 2-step process. Before the FactoryTalk Historian Asset 
Framework can be installed, the FactoryTalk Service Platform is required as a 
prerequisite, as is the Microsoft .NET Framework 4.8.

Install FactoryTalk Services Platform

Perform these steps to install FactoryTalk Services Platform.

1. Navigate to the installation files.
c:\Install Files\7.00.00-FTHistorian-SE-DVDDL\

2. Select Setup.exe.

3. Select ‘Install FactoryTalk Historian Site Edition’. 

4. Select ‘Install FactoryTalk Services’.

5. Select ‘Install FactoryTalk Services’ on this screen as well.
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6. Select 'Customize’.

7. Clear all software products except for FactoryTalk Services Platform and select 
Install.

8. Read the EULA, and select Accept all.

The installation takes several minutes to complete. The Microsoft .NET 
Framework 4.8 component may also be installed. If so, a restart is 
required.

9. Select 'Restart now' if prompted or if the installation is complete.
Rockwell Automation Publication 9528-UM001I-EN-P - February 2021 65



Chapter 5          Configure PlantPAx System Servers
10. Log in to the SQL server again. The installation may continue after the 
restart. Let it complete.

11. Select 'Restart now' once the installation is completed.

Specify the FactoryTalk Directory Location

After the FactoryTalk Service Platform has been installed, now is a good time to 
specify the network FactoryTalk Directory location, which is typically on the 
PASS.

1. Select the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Select Yes to allow the application to make changes to the device.
3. In the FactoryTalk Directory Server Location Utility dialog box, Select 

Browse (ellipsis '…').

4. Enter your FactoryTalk Directory Administration Console credentials 
into the login screen and click OK.

5. Select Remote computer and click Browse. 

6. Navigate the network to find the computer name of the server (typically 
PASS) that is hosting the FactoryTalk Directory services. Click OK.

7. Select OK to accept the location.

8. Select OK to finalize the location.
9. When prompted, enter your credentials and click OK.
10. Restart after you make this change.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
turned on. If Browse is inactive, type the computer name of the 
virtual machine that is hosting the FactoryTalk Directory.
66 Rockwell Automation Publication 9528-UM001I-EN-P - February 2021



Chapter 5          Configure PlantPAx System Servers
Install Historian Asset Framework
1. Navigate to the installation files.

c:\Install Files\7.00.00-FTHistorian-SE-DVDDL\Redist\PIServer\
2. Double-click PI-Server_2018-SP3-Patch-1_.exe
3. An installation wizard to complete install of Asset Framework appears. 

Complete the wizard as follows:

Wizard Page Action
Maintenance Select Modify.

Feature Selection

From Server Roles, Select AF Server.

Feature Rules Accept defaults.

SQL Server Connection

Enter the server name that will host the Asset Framework SQL database.

For database setup, select both AF SQL database scripts and AF SQL script execution.
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Add Local User to the SQL 
Server

The installers for Rockwell Automation software use Windows Authentication 
instead of SQL Server Authentication. To complete the installation of Rockwell 
Automation software in system elements that connect to the SQL server, add a 
local administrator account to the SQL server login. These steps are to be 
performed regardless if you use a Historian server collective.

1. On the virtual image desktop, click the Programs icon and choose 
Microsoft SQL Server Tools 18>Microsoft SQL Server Management 
Studio 18. 

2. On the Connect to Server dialog box, log in to the 'sa' account with SQL 
Server Authentication. 

RTQP Engine Accept defaults.
RTQP Engine Rules Select ‘Yes, I want to use a self-signed certificate.’
Service Accounts Accept defaults.
Summary Select Modify.
Installation Progress Select Modify when the installation progress has completed.
Complete Verify the modify completed successfully. Select Close.

Wizard Page Action

IMPORTANT At the end of the installation process (approximately 15…20 
minutes), the Release Notes display in a separate window. The 
installation process is not complete until you close the Release 
Notes window.
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3. Type the password that you created during the SQL installation (see 
Configure the SQL Virtual Server).

4. Select Connect.
5. In the Object Explorer, right-click Security and choose New>Login. 

6. Select Search next to Login Name on the Login - New window.
7. Enter your security credentials.
8. On the Select User or Group dialog page, Select Advanced. 

9. In the Select User or Group dialog box, Select Find Now. 

The Search Results are populated.
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10. In the Search Results area, select the local administrator account that is 
logged in and select OK. 

The ‘object name’ area on the Select User or Group dialog box is 
populated. 

11. Select OK. 
12. The Login name is populated on the Login - New window.
13. Select OK. 

Configure the Historian 
Virtual Server

This template represents a base installation of a FactoryTalk Historian SE 
server. The template excludes optional features, such as Advanced Server or 
Datalink.

The first step is to decide whether your Historian is going to be set up as a 
collective of servers or as a standalone Historian server. This decision affects 
the following:

• Where the SQL database is installed
• Where the Historian Asset Framework software is installed 

Historian Collective

A Historian collective is recommended for PlantPAx systems. 

A collective is composed of two or more FactoryTalk Historian servers that are 
configured to store and write identical data on each server for high availability. 
The server collective receives data from one or more interfaces and responds to 
requests for data from one or more clients. When one server becomes 
unavailable, another server that contains the same data responds to requests 
for that data.

If you are implementing a collective, you must deploy two Historian server 
virtual machines. Complete all sections of this manual for each Historian 
server. 

Before configuring the server, complete the following tasks:

• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server.
• Common Windows Configuration
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Once you have completed these tasks, see the PlantPAx DCS Configuration 
and Implementation User Manual, publication PROCES-UM100, for Historian 
configuration procedures, such as:

• Configuring Servers for a Collective
• Creating a Collective
• Client to server connections
• Historian to FactoryTalk Directory Connection
• Configuring Redundant Node Interfaces
• Configuring PI Performance and PI Buffering
• Configuring Data Collection
• Configuring Historian Asset Framework

Additional Historian Resources

Refer to the PlantPAx DCS Configuration and Implementation User Manual, 
publication PROCES-UM100, for Historian configuration procedures.

When the template is installed, we recommend that you review the FactoryTalk 
Historian publication at http://literature.rockwellautomation.com/idc/
groups/literature/documents/in/hse-in025.pdf). 

IMPORTANT See the pages that are referenced in the FactoryTalk Historian SE 
Installation and Configuration Guide, publication HSE-IN025A:
• Verify that Historian Services are Running 
• Verify that Historian Server is Updating Data for Default Tags
• Prepare PI MDB to AF Synchronization
• Create Security Mappings
• Adding the Server to the FactoryTalk Directory Connection
• Assigning License Activations to the Historian Server 
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Configure the Batch Virtual 
Server 

This section provides procedures to install FactoryTalk Batch independently, with 
FactoryTalk eProcedure®, or with Event archiver.

Before configuring the server, complete the following tasks:
• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server.
• Common Windows Configuration

Specify FactoryTalk Directory Location

Complete these steps to specify the FactoryTalk Directory location.
1. On the virtual image desktop, select the Programs icon and choose 

Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory 
Location. 

2. In the FactoryTalk Directory Server Location Utility dialog box, select 
Browse (ellipsis '…').

3. In the FactoryTalk Directory Server Configuration dialog box, select 
Remote Computer.

4. Enter the name of your PASS server, or select Browse (ellipsis '…'), search 
for, and select your PASS server.

5. Select OK
6. On the FactoryTalk Directory Server Location Utility dialog box, select 

OK to accept the changes. 

7. Log in to the FactoryTalk server when prompted.
8. Restart the virtual machine.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
enabled.
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Install FactoryTalk Batch

The Batch virtual server provides efficient, consistent predictable batch 
processing and supports the reuse of code, recipes, phases, and logic. 
FactoryTalk Batch combines the ISA S88 standard with proven technology that 
provides the flexibility you need to supply your product to market faster.

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.
3. When the Setup window displays, select Next.
4. Clear the checkbox for FactoryTalk Event Archiver. Leave FactoryTalk 

Batch v14.00 checked. 
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5. Permission requested. Check to allow changes to this computer.

6. Select Network Directory.
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7. Enter a user name and password for the batch server.

8. Select Install.
9. On the EULA page, read the license agreement and click 'Accept all'. 

Installation takes approximately 15 minutes.
10. Select whether to activate now or later. You must be connected to the 

Internet to activate now.
11. Select Close.

Install FactoryTalk eProcedure

The eProcedure template lets you step through the process of creating and 
commanding a batch. You can view equipment or procedures for batches 
running within the plant. 

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.
3. When the Setup window displays, select Customize.

IMPORTANT You must have FactoryTalk Batch installed on the server to complete 
the following procedure.
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4. Check FactoryTalk eProcedure v14.00 and click Next.

5. Select Network Directory and click Next. 
6. Enter a user name and password for the batch server.
7. Select Modify.
8. On the EULA page, read the license agreement and Select 'Accept all'.
9. Select Close when the modification is complete.

Install FactoryTalk Event Archiver

Complete these steps to install the FactoryTalk Event Archiver to insert batch 
record data.

1. On the desktop, double-click the shortcut to the Batch Installation file 
folder. 

2. Double-click Setup.exe.
3. When the Setup window displays, click Customize.

IMPORTANT You must have FactoryTalk Batch installed on the server to complete 
the following procedure.
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4. In the FactoryTalk Batch window, select FactoryTalk Event Archiver 
v14.00.

5. Select Next.
6. Enter your SQL server name. Use the Default Instance, Source Name, 

and Include Batch Reports.

7. Select Next.
8. Select Modify once the connection is validated.
9. On the EULA page, read the license agreement and select 'Accept all'.
10. Select Close once the modification is complete. Installation takes 

approximately 3 minutes.
Rockwell Automation Publication 9528-UM001I-EN-P - February 2021 77



Chapter 5          Configure PlantPAx System Servers
Complete Batch Installation

At this point, the FactoryTalk Batch virtual server is ready for use. Review the 
Installation Guide for FactoryTalk Batch, publication BATCH-IN002. 

We recommend that you use a domain. If the Batch server is in a workgroup, 
complete these additional tasks:

• Add an incoming firewall rule
• Disable Administrative Approval Mode

For these procedures, see the Batch Installation Guide (‘Configure Batch 
Server to run in a Workgroup’) and the eProcedure manual. 

• The FactoryTalk Batch Installation Guide is in your template at C:\Install 
Files\Batch Installation Software\14.00.00-FTBatch-DVD

• The FactoryTalk Batch Administrator’s Guide is in your template at c:\ 
Program Files (x86)\Commion Files\Rockwell\Help. 

Configure the Asset 
Management Virtual Server

An asset management server (AppServ-Asset) helps to manage and maintain 
plant operations. The AppServ-Asset server provides controller data backup for 
disaster recovery, diagnostics, calibration, and real-time monitoring. The 
server also audits equipment and network health to improve overall
resource availability.

Before configuring the server, complete the following tasks:

• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server
• Common Windows Configuration

Configure a Firewall

This section describes how to enable a firewall.

1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>Windows Firewall Configuration 
Utility. 

2. If the firewall has not been enabled, the following dialog box can open. 
Select Yes to enable the firewall and continue. 

3. In the Rockwell Software Windows Firewall Configuration Utility 
window, select Accept. If no changes are required, select Exit.

4. Select OK on the Confirm Windows Firewall Changes dialog box.

IMPORTANT Before proceeding, there must be a connection between this 
computer and the computer where the FactoryTalk Directory 
resides. There must also be a connection between this computer 
and the SQL server.
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5. The utility configures the Windows firewall and the firewall is set to a 
new state (if different).

Specify FactoryTalk Directory Location

In this section, you specify the location of the FactoryTalk Directory.

1. On the virtual image desktop, click the Programs icon and choose 
Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory 
Location. 

2. In the FactoryTalk Directory Server Location Utility dialog box, select 
Browse (ellipsis '…').

3. In the FactoryTalk Directory Server Configuration dialog box, select 
Remote Computer. Enter the name of your PASS server, or select Browse 
(ellipsis '…'), search for, and select your PASS server. 

4. On the FactoryTalk Directory Server Location Utility dialog box, select 
OK to accept the changes. 

5. Log in to the FactoryTalk server when prompted.
6. Restart the virtual machine.

Create a New Inbound Rule

There must be an inbound rule that allows a connection through the firewall to 
the AppServ-Info (SQL) server.

1. On the virtual image desktop, click the Programs icon and choose 
Administrative Tools>Windows Firewall with Advanced Security.

2. In the Windows Firewall with Advanced Security, select Inbound Rules.
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3. Right-click Inbound rules and select New Rule. 

4. In the Rule Type dialog box, select Port and then select Next. 
5. Select TCP and Specify local ports.
6. Type '1433' as the specific local port. 
7. Select Next. 
8. Select 'Allow the connection' and then select Next. 
9. Make sure that all boxes are checked and select Next.

10. Enter External SQL Connection in the Name field and click Finish.
11. The firewall now permits connections to the external SQL server in a 

secure manner.
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Configure FactoryTalk AssetCentre Software

Configure FactoryTalk AssetCentre (FTAC) server settings stored in the 
FactoryTalk Directory.

1. Navigate Programs>Rockwell Software>FactoryTalk Asset Centre 
Server>Server Settings to launch the Server Setting Utility.

2. Enter a user name and password and click OK.
3. Enter the server location by typing the new computer name.
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Update FactoryTalk AssetCentre SQL Instance

If the FactoryTalk AssetCentre server was installed before renaming the 
computer and/or specifying a SQL database location, you must update the 
FactoryTalk AssetCentre SQL server instance by using select AssetCentre 
utilities.

1. On the FactoryTalk AssetCentre server computer, locate the application 
utilities in the FTAC Server Repair folder on the desktop.

2. Start by running the FTAssetCentre.DBInstaller.exe utility, which will 
install/upgrade the database. Enter the Server information based the 
edition of SQL. 
• Enter the SQL server computer name and instance for SQL Server 

Standard. For example, PLANTPAXSQL\PAxINSTANCE
- If using the default SQL instance, enter only the SQL server computer 

name.
• Enter ".\sqlexpress" if using SQL Server Express.

3. Run the FTAssetCentre.AosCatalogImport.exe utility, which imports the 
AssetCentre Catalog data into the database. 

4. Make note of the FTAssetCentre.DataSourceEditWizard.exe utility. This 
utility can change the system password that FactoryTalk AssetCentre 
server uses to connect to the SQL Server database and can also change 
the SQL Server that is used by FactoryTalk AssetCentre.
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5. Restart FactoryTalk AssetCentre server computer. 

Configure the AppServ-
OWS/AppServ-EWS Virtual 
Servers

This section describes procedures for configuring an AppServ-OWS and 
AppServ-EWS. The procedure is the same for both servers.

Application servers for EWS and OWS allow multiple instances of EWS and 
OWS workstations to be deployed by using Microsoft Remote Desktop 
Services (RDS).

Before configuring the server, complete the following tasks:

• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server if deployed on a server.
• Common Windows Configuration if deployed on a workstation.

The Rockwell Automation software for the AppServ-OWS and AppServ-EWS 
virtual templates is included and pre-installed in the virtual image templates, 
but not activated. See Software Product keys and Activations for activation 
procedures. See PlantPAx Virtual Image Template Catalog Numbers for 
product catalog numbers.

Specify the FactoryTalk Directory Location

Complete these steps to specify the network FactoryTalk Directory location for 
EWS and OWS workstations.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow the application to make changes to the device.
3. In the FactoryTalk Directory Server Location Utility dialog box, click 

Browse (ellipsis '…').

4. Type your FactoryTalk Directory Administration Console credentials into 
the login screen and click OK.

IMPORTANT If you already own individual product activations, these activations 
also can be used to activate the instances of these virtual image 
templates you deploy. Each instance requires its own Rockwell 
Automation license and Microsoft license.

IMPORTANT To complete this procedure, a PASS server must be configured on 
your system. The workstation being configured must have an 
established connection with the PASS server.
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5. Click Remote computer and click Browse. 

6. Navigate the network to find the computer name of the server (typically 
PASS) that is hosting the FactoryTalk Directory services. Click OK. 

If Browse is inactive, type the computer name of the virtual machine that 
is hosting the FactoryTalk Directory.

7. Select OK to accept the location.
8. Select OK to finalize the location.

9. When prompted, type the FactoryTalk Directory Administrator 
username and password and click OK.

10. Restart after you make this change.

Install PI Builder Excel Add-in for Microsoft Excel

PI Builder is a Microsoft Excel® add-in that lets you use Excel to create, view, 
and modify PI points and Asset Framework objects in your Historian database. 
With PI Builder, you can make bulk tag edits by importing and exporting your 
spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI 
Builder, which is included with the PI SMT and PI Data Archive setup kits (as 
part of the PI AF Client installer).

If Microsoft Excel was installed after the Historian software, the AF Client 
features will must be modified to include the PI Builder feature.

1. Run the PI-Server_2018-SP3-Patch-1.exe file included as part of the 
installation media in the \Redist\PIServer\ folder.

2. Choose to Modify the installation and click Next.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
turned on.

Tip: The credentials were configured in Configure the PASS Virtual Server.

IMPORTANT This section is not performed for OWS. Proceed to Configure Remote 
Desktop Services on page 85.

IMPORTANTIMPORTANT Microsoft Excel software must be installed for these procedures. 
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3. Select PI Builder on the Individual Features tab and click Next.

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF 
database and for PI points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.
2. In the Connections group on the upper left corner. Select your Data 

Server, Asset Server, and Database as available.

Configure Remote Desktop Services

The AppServ-OWS and AppServ-EWS provide PlantPAx users with an 
alternative to the standard OWS and EWS client machine (physical or virtual). 
Both application servers use Microsoft Remote Desktop Services (RDS). RDS 
technology allows multiple instances of the OWS and EWS from one virtual 
server. 

This architecture is ideal for PlantPAx users that use thin clients as Operator 
and Engineering workstations. 

IMPORTANT A valid FactoryTalk activation is still required for each instance of 
the OWS and EWS that is in use.
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Microsoft RDS (formerly known as Terminal Services) is a standard role that is 
built into the Windows server family of operating systems. RDS provides 
remote access to applications and data on a remote computer over a network. 
This solution minimizes the amount of information traveling across your 
network.

RDS can be used as an administrative tool to connect to a remote machine and 
perform maintenance tasks. RDS can also be used as a thin client solution to 
let remote clients execute applications or even access the entire desktop of the 
host server.

The thin client solution is a transparent system that runs applications and 
performs data processing and storage functions on a remote computer. This 
solution minimizes the amount of information traveling across your network. 
While multiple sessions can run on one server, each user can see only their 
individual session. Only the user interface is shown on client, user input from 
client is redirected over the network to the remote desktop session. User's 
desktops are transmitted to clients for display by using terminal emulation 
software. Similarly, the software sends command functions such as keyboard 
inputs and mouse clicks across the network between the client and the server.

The PlantPax AppServ-OWS and AppServ-EWS are pre-configured with the 
RDS server role. This configuration provides a thin client solution for 
FactoryTalk View SE clients.

Users, with the proper credentials, can log in into the AppServ-OWS and 
AppServ-EWS and run the desired application.

One Rockwell Automation software activation key is required for each remote 
desktop session.
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Remote Desktop Services with FactoryTalk View SE

RDS features the following benefits with FactoryTalk View SE software:
• Increased network flexibility: RDS lets you deploy thin and ultrathin 

clients on the plant floor or out in the field. The minimal requirements of 
RDS clients allow for various thin products that are designed to handle 
most environmental conditions. These conditions include radical 
temperatures, extreme vibrations, or areas where mobility is key.

Users can gain access to an RDS over any Transmission Control Protocol/
Internet Protocol (TCP/IP) connection, including the following:
- Remote access
- Ethernet
- Internet
- Wireless
- Wide area network (WAN)
- Virtual private network (VPN)

• Lower cost of ownership: A thin client typically consists only of the 
operating system and the Remote Desktop Connection software. RDS 
delivers a virtual Windows Server experience from server to clients, 
regardless of what operating system the client uses.

• Minimize downtime: Upgrade your entire FactoryTalk View SE 
installation with one operation. Because FactoryTalk View SE products 
install only on the server side, any future software upgrades are limited 
to the server, making software upgrades on clients a thing of the past.

• Improve data security: A FactoryTalk View SE architecture that uses RDS 
is less vulnerable to security threats. RDS lets you focus your security 
measures on the server because all data is processed on the server, which 
you can manage in a secure location.

RDS has the following limitations with FactoryTalk View SE software:
• The Microsoft RDS protocol does not transfer the physical display aspect 

ratio (height/width proportion) from the server to its clients. Clients 
must specify the display properties (resolution, aspect ratio, color depth, 
and so forth) for each session they create. Verify the appearance of the 
application visually on the Remote Desktop clients before placing the 
system in a production environment, modifying graphics as necessary.

• If your FactoryTalk View SE client configuration (.cli) enables 'Show 
Diagnostics List', the list shows all activity from all clients that run on the 
same Remote Desktop session host. Although each instance of the 
FactoryTalk View SE client runs in a separate session, they are all hosted 
on the same computer. And, they share common log resources. This 
amount of activity can be confusing for HMI operators because they see 
diagnostic activity on their client that they did not initiate.
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Additional Services

Configure the VantagePoint 
Virtual Server

AppServ-Info can be configured as a decision support tool by using 
FactoryTalk VantagePoint EMI software. VantagePoint EMI is a powerful web-
based business intelligence solution that is designed specifically for industrial 
environments with premier Logix integration. VantagePoint EMI integrates 
all data into one information management and decision support system by 
connecting to your Logix controllers, OPC data sources, Historians, and SQL/
Oracle Databases. With an AppServ-Info (VantagePoint) system element in 
your PlantPAx DCS, you can access your production data from anywhere 
including your shop floor devices, personal computer, or your mobile phone or 
tablet.

Before configuring the server, complete the following tasks:
• Deploy PlantPAx Virtual Machines.
• VMware ESXi vCenter Server
• Common Windows Configuration

Specify the FactoryTalk Directory Location

1. Select the Programs icon and choose Rockwell Software>FactoryTalk 
Tools>Specify FactoryTalk Directory Location.

2. Select Yes to allow the application to make changes to the device.

3. In the FactoryTalk Directory Server Location Utility dialog box, select Browse 
(ellipsis '…').

4. Enter your FactoryTalk Directory Administration Console credentials into the 
login screen and select OK.

IMPORTANT You can add additional role services to your server depending on 
your specific deployment of RDS and connectivity needs. These 
added services can add additional configuration beyond which this 
base RDS has been configured for.

Tip: Remote Desktop Services uses its own method of licensing clients that log 
on to Remote Desktop Services servers. This method is separate from licensing 
for the Windows Server family of operating systems. Therefore, AppServ-OWS 
and AppServ-EWS Remote Desktop Connections must receive a valid license. 
This license must be issued by a Remote Desktop Licensing Server before they 
can log on to a Remote Desktop Session Host or Connection Broker.
For volume licensing of these components, contact your Microsoft distributor.

IMPORTANT To complete this procedure, a PASS server must be configured on 
your system. The workstation being configured must have an 
established connection with the PASS server.
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5. Select Remote computer and select Browse. 

6. Navigate the network to find the computer name of the server (typically PASS) 
that is hosting the FactoryTalk Directory services. Select OK. 

If Browse is inactive, type the computer name of the virtual machine that is 
hosting the FactoryTalk Directory.

7. Select OK to accept the location.

8. Select OK to finalize the location.

9. When prompted, type the FactoryTalk Directory Administrator username and 
password and select OK.

10. Restart after you make this change.

Install VantagePoint Server Software

1. Navigate to the installation setup folder:
c:\Install Files\8.20.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe. 

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
turned on.

The credentials were configured in Configure the PASS Virtual Server.
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3. Select Install FactoryTalk VantagePoint.

4. On the next dialog screen, select Install FactoryTalk VantagePoint.

5. If you have not installed Microsoft Excel, you see this warning. Read the 
warning and, according to your needs, click Yes or No. 

In our example, we click Yes to show the installation of FactoryTalk 
VantagePoint when Microsoft Excel is not installed in the VantagePoint Server.

6. Select Next on the Wizard Welcome page.

7. Read the License Agreement, select 'I accept the terms in the License 
Agreement’.

8. Select Express on the 'Choose Setup Type' page.

A warning appears if you have not installed Microsoft Excel. 

9. Select OK. 
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10. In the Database Connection Information page, type the name of the SQL 
server, click SQL Server, and type credentials for the database. 

11. Select Next.

12. Enter the Domain name, user name for the Domain controller, and password 
for the Domain controller in the System/Office User page

13. Select Next.

14. Select Install.

15. Select Finish. 
A DOS window opens to finish the configuration. It closes automatically.

Install Microsoft Excel Add-In

The Microsoft Excel add-in enables FactoryTalk VantagePoint to generate 
Excel spreadsheet reports. Complete these steps to install the Excel Add-On 
software.

1. Navigate to the installation setup folder:
c:\Install Files\8.20.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe. 

IMPORTANT Type the password that you created when completing the SQL 
Server installation when deploying the SQL Server template.

IMPORTANT If you are installing FactoryTalk VantagePoint in a VantagePoint 
server with Microsoft Excel installed on it, install the Microsoft Excel 
Add-In for FactoryTalk VantagePoint during the FactoryTalk 
VantagePoint installation.
Rockwell Automation Publication 9528-UM001I-EN-P - February 2021 91



Chapter 5          Configure PlantPAx System Servers
3. Select Install FactoryTalk VantagePoint.

4. Select Install FactoryTalk VantagePoint.
5. Select Next on the Wizard Welcome page.
6. Select Modify on the Modify, Repair, or Remove installation page. 
7. Select the VantagePoint Office pull-down menu and select ‘Will be 

installed on local hard disk drive.’ 

8. Select Next.
9. Select Install.
10. Enter the Domain name, user name for the Domain controller, and 

password for the Domain controller in the System/Office User page
11. Select Next. 
12. The Microsoft Excel software program starts and a VantagePoint 

Configuration warning appears.
13. Close Microsoft Excel and click OK in the warning. 
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14. A series of VantagePoint server configurations are performed. You 
return to the VantagePoint Manager window when the configurations 
are done.

15. Select Finish.
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Notes:
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Chapter 6

PASS-C / OWS ISO Images for PCs

This chapter describes how to install and configure physical computers using 
the PASS-C server and OWS workstation pre-built ISO images.

This option provides for multiple system elements to be consolidated on the 
same physical server, which is referred to as PASS-C.   Ideal for small and 
medium systems, we suggest that your system not have more than 2000 I/O 
points for this consolidated server.

The pre-built ISO images contain a Windows Server 2016 operating system 
and pre-installed applications. The PASS-C image supports system elements 
such as:

• FactoryTalk® Directory
• Data server
• HMI server (one server license only is required)
• Alarm server
• FactoryTalk Historian
• FactoryTalk VantagePoint®
• FactoryTalk AssetCentre
• SQL server

The OWS image contains a Microsoft® Windows 10 Enterprise LTSC 2019 
operating system and supports client-side elements. The following elements 
are suitable for interfacing with a PASS-C or even with a virtual PASS:

• HMI Client
• FactoryTalk AssetCentre Client

IMPORTANT The USB device contains a bootable installation of a PASS-C server 
or OWS workstation.
A purchase of a PASS-C or OWS ISO includes an Electronic Software 
Delivery (ESD) version available for download from the Product 
Compatibility and Download Center. The ESD is one file (.ISO type) 
which can be used to create your own bootable device. Typical 
bootable devices that you can create are DVDs and USB storage 
devices. We do not provide procedures for creating bootable 
devices. Several third-party resources are available (for example, 
PowerISO, RUFUS, and so on) for purchase. 
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Install Pass-C Operating 
System

The following steps are comparable to a retail Windows Server 2016 Standard 
operating system, the difference is the PASS-C ISO image contains additional 
pre-installed software.

1. Make sure that your computer is capable of booting from a USB drive. 
Enter the BIOS Setup as the computer is powering on (typically by 
pressing the F2 key). Make sure that the Boot options include booting 
from a USB device.

2. Shut down the computer and connect the USB drive.
3. Turn on the computer. While the computer is powering on, strike the F12 

key to open the boot options screen. 
4. Select the USB device containing the PASS-C installation.
5. On the Windows Setup dialog box, select your options from the

pull-down menus.
6. Click Next.
7. Enter the product key or Click I don’t have a product key.
8. Select Install Now. 
9. Select “I accept the license terms”, and click Next.
10. Custom (installation).

11. To store the installation, select the hard disk drive.
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If necessary, delete any existing drive partitions and format the drive 
location.

12. Select Next. The installation typically takes about an hour. The computer 
automatically restarts. You must log on to complete the installation.

13. Enter an Administrator password (for your system).
14. Enter a confirmation password.

Configure Windows Settings 1. Login using the administrator account and password that was created in 
the previous step. 

2. In the Product Key window, enter a valid Windows Server Product Key 
and click OK. 

3. Verify that the product key is correct and select Yes.
4. Select OK in the message window when the product key was installed 

successfully.
5. Install any required drivers for your hardware (graphics, Ethernet, 

chipset, and so on).
6. Right-click the windows start icon and select ‘System’.

7. Select ‘Change Settings’.
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8. Select Change on the System Properties dialog box. 

9. Enter the new computer name. Click OK. 

10. Acknowledge any prompts that indicate that a restart is required.

11. Select the Advanced tab.
12. Select Settings in the Performance section.
13. Choose the Advanced tab.
14. Select Background services in the Processor scheduling section to adjust 

for the best performance.
15. To help protect against viruses and security threats, select the Data 

Execution Prevention tab.

IMPORTANT Do not use spaces or any special character symbols.

IMPORTANT Do not restart your computer now. 
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16. Select ‘Turn on DEP for essential Windows programs and services only’.

17. Acknowledge the prompt that changes take effect on restart.

18. Select OK to close the window.
19. On the Remote tab, select ‘Allow remote connections to this computer’.

IMPORTANT Do not restart your computer now. 
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20. Select OK to enable the Remote Desktop Firewall exception.

21. Remove the check mark from the ‘Allow connections only from 
computers ...’ box and click Apply.

22. Select Restart Later.
23. Navigate to the Control Panel.
24. Select Power Options.
25. Select ‘High Performance’ in the Preferred Plans section.

Ethernet Network Adapter Settings

The PlantPAx® DCS Configuration and Implementation User Manual, 
publication PROCES-UM100 contains configuration information procedures 
for Domain or Workgroup infrastructures, such as managing IP addresses and 
computer name resolution.

To help with stable communications, we recommend configuring the speed, 
duplex, and power management settings for the Ethernet adapter.

1. Navigate to the Control Panel.
2. Click Network and Internet.
3. Click Network and Sharing Center.

IMPORTANT Do not restart your computer now. 

IMPORTANT The configuration parameters that are described in this section 
apply to typical network infrastructures recommended for PlantPAx 
systems. Note that speed/duplex settings may vary depending upon 
the network switch configuration.
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4. In the Network and Sharing Center window, click Change Adapter 
Settings.

5. Right-click the Ethernet network connection and choose Properties. 
6. If asked, enter your password and click Yes.
7. In the Ethernet Properties dialog box, select Configure.

8. Select the Advanced tab.
9. Select Speed and Duplex and then choose Auto Negotiation.
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10. Select the Power Management tab.
11. Select the ‘Allow the computer to turn off this device to save power’ 

checkbox.
12. Select OK.
13. Restart your computer.

Configure System Software The PASS-C image contains SQL Server 2016 Express instance for use with 
Asset Centre and other applications. This is a free edition of SQL Server, with 
some limitations, a 10 GB maximum database size, and is intended for small 
PlantPAx system applications.

For larger PlantPAx system applications, a standard SQL Server prepared 
instance can be completed. Standard SQL Server 2016 offers an evaluation 
period for 180 days, before it expires and will require a licensed product key.

Complete SQL Server 2016 Installation

Do the following if you choose to use SQL Server 2016:

1. On the virtual image desktop, click the Programs icon and choose 
Microsoft SQL Server 2016>Configuration Tools>Complete SQL Server 
2016 Installation

2. Click Yes to allow the changes to be made to the device.
3. An installation wizard to complete image of SQL Server 2016 appears. 

Complete the wizard as follows:

IMPORTANT SQL Server Express has already been installed on this machine. If 
you plan to use SQL Express, skip to SQL Registered Server Names. If 
you plan to use SQL Server 2016 Standard, continue with the next 
procedure.

IMPORTANT For the remainder of the installation, default selections are shown 
and we do not recommend any changes. Some PlantPAx 
configurations require these default selections. We recommend 
accepting the defaults, prove the system, and make changes later. 
Corresponding notice is provided where exceptions to this 
configuration are considered for changing now. Otherwise, simply 
click Next on the following screen captures to complete the process.

Wizard Page Action
Setup Support Rules Select OK once the rules have passed.

Product Key • Select Specify a free edition and then select Evaluation from the pull-down menu for a 90-day trial.
• Select Enter the product key and type your key to license your software.

License Terms Read the license terms, and select ‘I accept the license terms’
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Microsoft Update Accept Default
Complete Image Rules Select Next once the rules have passed
Select Prepared Features Select Complete a prepared instance of SQL Server 2016
Feature Review Review the features to be configured
Instance Configuration Select Default Instance
PolyBase Configuration Select Use this SQL Server as a standalone PolyBase-enabled Instance
Server Configuration Select Default

Database Engine Configuration

Select Mixed Mode
Select Add Current User

Wizard Page Action
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Analysis Services Configuration

Select Multidimensional and Data Mining Mode
Select Add Current User

Reporting Services Configuration Select Reporting Services Native Mode > Install and Configure
Feature Rules Select Next once the rules have passed
Complete Image Process Select Next once Complete
Complete Select Close to complete the wizard

Wizard Page Action
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SQL Registered Server Names

Use the Microsoft SQL Server Management Studio to update the registered 
server names. This procedure applies to SQL Express and SQL Server. 

1. Log in to the computer as Administrator.
2. Navigate to Programs>Microsoft SQL Server Tool 18\Microsoft SQL 

Server Management Studio 18 and launch SSMS. 

3. Connect to the SQL server.
• For SQL Express, enter the server name\instance as 

<ComputerName>\SQLEXPRESS

Login for SQLEXPRESS uses SQL Server Authentication 'sa' account 
and default password 'Rockwell1'

• For SQL Server enter the servername without instance as simply 
<ComputerName>

Login for SQL Server was defined during installation.

IMPORTANT When using SQLEXPRESS, after you complete the initial connection, 
you can change your sa password under Options.
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4. In SQL Server Management Studio use the menu to select 
View>Registered Servers.

• Green icon indicates connected servers
• Blue icon indicates unconnected servers

5. Record any unconnected server names, for use in the Update SQL after 
Computer Rename section.

6. Right click any unconnected servers and select properties.
7. Use the drop down to select the server name and then edit the registered 

server name to represent this computer.
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Update SQL after Computer Rename

When you change the name of the computer that is running SQL, use the 
following procedure to update system metadata for remote connections. This 
procedure applies to SQL Express and SQL Server.

1. In SQL Server Management Studio, select 'New Query' from the toolbar.
2. Enter the following code into the SQLQuery*.sql field, replacing old 

computer name with the unconnected server name recorded earlier and 
supplying the new computer name.

EXEC sp_dropserver ‘<oldcomputername>\instance’;
GO
EXEC sp_addserver ’<newcomputername>\instance’ , 
local;
GO 

3. Select the 'Execute' button, from the toolbar, to run the query. 
4. To verify the update, select 'New Query' from the toolbar and enter the 

following code into the SQLQuery*.sql field

select * from sys.servers;

Add New Administrator Login to SQL

Use the SQL Server Management Studio to create a security login for the new 
local administrator. This procedure applies to SQL Express and SQL Server.
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1. Expand the Security folder and right-click the Logins folder to select New 
Login. 

2. Select Search.
3. Enter 'computername\administrator' in the object name box and select 

Check Names. 

4. Verify that the user is successfully verified and select OK.
5. Select Server Roles and checkboxes for public and sysadmin. 

6. Select Securables and then select Search.
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7. For the Add Objects dialog, select the last option for the server 
COMPUTERNAME\INSTANCE. 

8. The server name appears under Securables. In the Permission section, 
select Grant to enable the Connect SQL option. 

9. Select OK
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Delete Old Administrator Login to SQL

Prior to deleting the old administrator, use the SQL Server Management 
Studio to transfer the AssetCentre database ownership to the new 
administrator.

1. To transfer AssetCentre database ownership, select ‘New Query’ from the 
toolbar.

2. Enter the following code into the SQLQuery*.sql field and replace 
<computername> with the current computer name.

ALTER AUTHORIZATION ON DATABASE:: AssetCentre To 
[computername\Administrator]; 

3. Click the 'Execute' button to run the query and change ownership. 
4. Expand the Security>Logins folder from the SQL Server Management 

Studio configuration tree.
5. Right-click on prior or unused Administrator accounts and choose 

Delete. 

6. Select OK and accept any prompts.
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Configure AssetCentre User Account
1. Right-click on AssetCentreUser under Logins and choose Properties.
2. Configure a password for the account.

3. Select OK.
4. Close SQL Server Management Studio.
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Install Historian Asset Framework

The procedures in this section apply only if you plan to do the 
following:

• Use FactoryTalk Historian Asset Framework in your PlantPAx system
• Install Asset Framework Server on the Server

1. Navigate to the installation files.
c:\Install Files\7.00.00-FTHistorian-SE-DVDDL\Redist\PIServer\

2. Double-click PI-Server_2018-SP3-Patch-1_.exe
3. An installation wizard to complete install of Asset Framework appears. 

Complete the wizard as follows:

Wizard Page Action
Maintenance Select Modify.

Feature Selection

From Server Roles, Select AF Server.

Feature Rules Accept defaults.
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•

Verify the AFServers Database and Account

Complete these steps to verify that the Historian AF database and user group 
were added to your computer.

SQL Server Connection

Enter the server name that will host the Asset Framework SQL database.

For database setup, select both AF SQL database scripts and AF SQL script execution.

RTQP Engine Accept defaults.
RTQP Engine Rules Select ‘Yes, I want to use a self-signed certificate.’
Service Accounts Accept defaults.
Summary Select Modify.
Installation Progress Select Modify when the installation progress has completed.
Complete Verify the modify completed successfully. Select Close.

Wizard Page Action

IMPORTANT At the end of the installation process, the Release Notes display in a 
separate window. The installation process is not complete until you 
close the Release Notes window.
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1. Click the Programs icon and choose Microsoft SQL Server 
2018>Microsoft SQL Server Management Studio 18. 

2. Enter the server name. 
• The Server name is <ComputerName> if using SQL standard
• The Server name is <ComputerName>\SQLEXPRESS’ if using SQL 

Express.

3. Log on by using the ‘sa’ account and the password.

4. Select Connect.

IMPORTANT <ComputerName> = The computer name set in Configure Windows 
Settings

IMPORTANT After you complete the initial settings, change your logon and 
password settings under Options.
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5. From the SQL Server Management Studio configuration tree, expand the 
Databases folder and verify that PIFD appears in the list.

6. Expand the Security\Logins folder and verify that the AFServers user 
group was added.

7. If the PIFD database or AFServers group do not appear, reinstall the 
Historian Asset Framework.

8. Close SQL Server Management Studio.
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Configure the FactoryTalk 
Directory

1. Navigate to the FactoryTalk Directory Configuration Wizard.

2. Select both boxes under configure settings to configure the Network and 
Local directories and click Next.

3. Enter the administrator user name and password.

4. Select Close in the summary window once complete.

IMPORTANT Step 3 must be done twice. You have to enter a user name and 
password for each directory (local and network).
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Delete “Unused” Computer Names from Directory
1. Navigate to 

Programs>Rockwell Software>FactoryTalk Administration Console.
2. Select Network (directory) and click OK.
3. Expand System>Computers and Groups>Computers in the explorer 

pane.
4. Right-click any unused computer names and choose Delete. The original 

computer name, before it was renamed, typically shows up here. 

5. If a prompt appears, select Yes.
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6. Expand Users and Groups>User Groups in the explorer pane.

Recreate IIS_IUSRS User Group

Ensure the IIS_IUSRS user group is a windows-linked user group by removing 
the prior group and recreating for this new computer.

1. Right-click the IIS_IUSRS user group and choose Delete.
2. Select Yes.
3. Add the IIS_IUSRS user group and link with the new computer name.

From the Explorer pane, right-click the User Groups folder and choose 
New>Windows-Linked User Group.

4. Select Add.
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5. Select Advanced.

6. Select Find Now, select IIS_IUSRS, and select OK.

7. Verify that the user group is correct, and select OK.

8. Restart your computer.
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Configure FactoryTalk 
AssetCentre (FTAC) Server

Configure FactoryTalk AssetCentre (FTAC) server settings stored in the 
FactoryTalk Directory.

1. Navigate Programs>Rockwell Software>FactoryTalk Asset Centre 
Server>Server Settings to launch the Server Setting Utility.

2. Enter a user name and password and click OK.
3. Enter the server location by typing the new computer name, then click 

Apply. 

Update FactoryTalk AssetCentre SQL Instance

If the FactoryTalk AssetCentre server was installed before renaming the 
computer and/or specifying a SQL database location, you must update the 
FactoryTalk AssetCentre SQL server instance by using select AssetCentre 
utilities.
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1. On the FactoryTalk AssetCentre server computer, locate the application 
utilities in C:\Program Files (x86)\Rockwell Software\AssetCentre 
Server\Bin\ directory. 

2. Run the FTAssetCentre.DBInstaller.exe utility, which will install/upgrade 
the database. Enter the Server information based the edition of SQL. Use 
a period (.) for SQL Server Standard or enter ".\sqlexpress" if using SQL 
Server Express. 
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3. Run the FTAssetCentre.AosCatalogImport.exe utility, which will import 
the AssetCentre Catalog data into the database. 

4. Make note of the FTAssetCentre.DataSourceEditWizard.exe utility. This 
utility can change the system password that FactoryTalk AssetCentre 
server uses to connect to the SQL Server database and can also change 
the SQL Server that is used by FactoryTalk AssetCentre.

5. Restart FactoryTalk AssetCentre server computer. 

Configure FactoryTalk 
Historian

Remove Old Computer Names
1. Navigate to:

Programs>Rockwell Software>FactoryTalk Historian SE>FactoryTalk 
Historian SE System>AboutPI-SDK

2. In the left pane, click Connections, right-click the old server names, and 
choose Remove selected Server.

3. Close PI-SDK utility.

Install PI Builder Excel Add-in for Microsoft Excel

PI Builder is a Microsoft Excel® add-in that lets you use Excel to create, view, 
and modify PI points and Asset Framework objects in your Historian database. 
With PI Builder, you can make bulk tag edits by importing and exporting your 
spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI 
Builder, which is included with the PI SMT and PI Data Archive setup kits (as 
part of the PI AF Client installer).

If Microsoft Excel was installed after the Historian software, the AF Client 
features will need to be modified to include the PI Builder feature.

IMPORTANT This section is not performed for OWS. Proceed to Additional 
Historian Resources.

IMPORTANTIMPORTANT Microsoft Excel 32-bit software must be installed for these 
procedures. 
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1. Run the PI-Server_2018-SP3-Patch-1.exe file included as part of the 
installation media under the \Redist\PIServer\ folder.

2. Choose to Modify the installation and click Next.
3. Select PI Builder on the Individual Features tab and click Next 

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF 
database and for PI points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.
2. In the Connections group on the upper left corner. Select your Data 

Server, Asset Server, and Database as available.
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Additional Historian Resources

When the template is installed, we recommend that you review a FactoryTalk 
publication at http://literature.rockwellautomation.com/idc/groups/
literature/documents/in/hse-in025.pdf). 

Install VantagePoint Server 
Software

1. Navigate to the installation setup folder:
c:\Install Files\8.20.00-VantagePoint-EMI-DVD 

2. Double-click setup.exe. 

3. Select Install FactoryTalk VantagePoint.

4. On the next dialog screen, select Install FactoryTalk VantagePoint.

5. If you have not installed Microsoft Excel, you see this warning. Read the 
warning and, according to your needs, click Yes or No. 

IMPORTANT See the pages that are referenced in the FactoryTalk Historian SE 
Installation and Configuration Guide, publication HSE-IN025A:
• Verify that Historian Services are Running 
• Verify that Historian Server is Updating Data for Default Tags
• Prepare PI MDB to AF Synchronization
• Create Security Mappings
• Adding the Server to the FactoryTalk Directory Connection
• Assigning License Activations to the Historian Server 
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In our example, we click Yes to show the installation of FactoryTalk 
VantagePoint when Microsoft Excel is not installed in the VantagePoint Server.

6. Select Next on the Wizard Welcome page.

7. Read the License Agreement, select 'I accept the terms in the License 
Agreement’.

8. Select Custom setup type.
9. Choose the following options and select Next.

10. Enter a portal server name and select Next.
11. If you are using SQL 2016 Standard, accept the defaults and click Next. If 

you are using SQL Express, enter “.\sqlexpress” for the server and then 
click Next.
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12. If you have a local user account that is specified for VantagePoint, type 
the user name in the prompt. Use the computer name as the domain. If 
you do not have a local user account, select Local Account and a user is 
created.

13. If Microsoft Excel is installed, the software automatically launches. 
Acknowledge the prompts and close Excel.

14. Select Install.

15. Select Finish.
16. Wait for the installation to complete. A popup window appears that 

informs you the configuration is still running. It closes automatically.
17. Select Exit on the Vantage Point Installer.
18. Restart your computer.

Configure HMI

Once you have completed the previous tasks, see the PlantPAx DCS 
Configuration and Implementation User Manual, publication PROCES-
UM100, for PASS configuration procedures, such as:

• Configuring FactoryTalk components
• Configuring HMI, DATA, and ALARM servers
• Redundant PASS considerations
• Configuring runtime security

Install OWS Operating 
System

The following steps are comparable to a retail Windows 10 Enterprise 2019 
operating system, the difference is the PASS-C ISO contains additional pre-
installed software.

1. Make sure that your computer is capable of booting from a USB drive. 
Enter the BIOS Setup as the computer is powering on (typically by 
pressing the F2 key). Make sure that the Boot options include booting 
from a USB device.

2. Shut down the computer and connect the USB drive.
3. Turn on the computer. While the computer is powering on, strike the F12 

key to open the boot options screen. 

IMPORTANT Installation can take 20…30 minutes.
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4. Select the USB device containing the OWS ISO installation.
5. On the Windows Setup dialog box, select your options from the

pull-down menus.
6. Click Next.
7. Click Install Now. 
8. Click “I accept the license terms”, and click Next.
9. Click Custom (installation).

10. To store the installation, select the hard disk drive.
11. If necessary, delete any existing drive partitions and format the drive 

location.

12. Click Next.

The computer automatically restarts. You must log on to complete the 
installation.

Tip: The installation typically takes about an hour.
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Windows Out of Box Experience

The Windows Out of Box Experience (OOBE) consists of displays that require 
customers to accept the end users license agreement (EuLA), connect to the 
internet, log in with or sign up for a Microsoft Account, and share information 
with the OEM.

Complete these steps for the initial configuration of all virtual machines that 
were deployed using PlantPAx image templates.

Windows 10 Enterprise LTSC 2019 virtual machines require the following 
OOBE initialization:

1. Click ‘Skip for now’ for an internet connection.
2. On the EULA dialog box, read the license terms and Accept.
3. Type a user name and Next
4. Create a password, retype password to verify, and Finish.
5. Create security questions, and Next.
6. Click No when prompted to make Cortana your personal assistant.
7. Turn off all privacy settings for your device and Accept.
8. Enter the Windows product key.

Initial Windows Login

A logon message appears, prompting you to press Ctrl + Alt + Delete key 
combination to unlock'.

1. DO NOT press Ctrl + Alt + Delete for a virtual machine.
2. Instead press Ctrl + Alt + Insert. This is the VMware key combination to 

unlock.
3. Type the Administrator password that you created and Press Enter.

If you see the Other-User logon, type 'Administrator', type the administrator 
password that you created and Press Enter. Wait until you see the network 
message in the following steps.

4. Select 'Yes' to allow the PC to be discoverable.

If you skipped the product key earlier, another dialog window appears to 
remind you that Windows must be activated.

5. In the Product Key window, enter a valid Windows Server Product Key.
6. Verify that the product key is correct.
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7. Select OK in the message window when the product key was installed 
successfully.

8. Select OK in the activation window.

Configure Windows Settings 1. Login using the administrator account and password that was created in 
the previous step. 

2. In the Product Key window, enter a valid Windows Server Product Key 
and click OK. 

3. Verify that the product key is correct and select Yes.
4. Select OK in the message window when the product key was installed 

successfully.
5. Install any required drivers for your hardware (graphics, Ethernet, 

chipset, and so on).
6. Right-click the windows start icon and select ‘System’.

7. Select ‘Change Settings’.
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8. Select Change on the System Properties dialog box. 

9. Enter the new computer name. Click OK. 

10. Acknowledge any prompts that indicate that a restart is required.

11. Select the Advanced tab.
12. Select Settings in the Performance section.
13. Choose the Advanced tab.
14. Select Background services in the Processor scheduling section to adjust 

for the best performance.
15. To help protect against viruses and security threats, select the Data 

Execution Prevention tab.

IMPORTANT Do not use spaces or any special character symbols.

IMPORTANT Do not restart your computer now. 
130 Rockwell Automation Publication 9528-UM001I-EN-P - February 2021



Chapter 6          PASS-C / OWS ISO Images for PCs
16. Select ‘Turn on DEP for essential Windows programs and services only’.

17. Acknowledge the prompt that changes will take effect on restart.

18. Select OK to close the window.
19. On the Remote tab, select ‘Allow remote connections to this computer’.

IMPORTANT Do not restart your computer now. 
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20. Select OK to enable the Remote Desktop Firewall exception.

21. Remove the check mark from the ‘Allow connections only from 
computers ...’ box and click Apply.

22. Select Restart Later.
23. Navigate to the Control Panel.
24. Select Power Options.
25. Select ‘High Performance’ in the Preferred Plans section.

Ethernet Network Adapter Settings

The PlantPAx DCS Configuration and Implementation User Manual, 
publication PROCES-UM100 contains configuration information procedures 
for Domain or Workgroup infrastructures, such as managing IP addresses and 
computer name resolution.

To help with stable communications, we recommend configuring the speed, 
duplex, and power management settings for the Ethernet adapter.

1. Navigate to the Control Panel.
2. Click Network and Internet.
3. Click Network and Sharing Center.

IMPORTANT Do not restart your computer now. 

IMPORTANT The configuration parameters that are described in this section 
apply to typical network infrastructures recommended for PlantPAx 
systems. Note that speed/duplex settings may vary depending upon 
the network switch configuration.
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4. In the Network and Sharing Center window, click Change Adapter 
Settings.

5. Right-click the Ethernet network connection and choose Properties. 
6. If asked, enter your password and click Yes.
7. In the Ethernet Properties dialog box, select Configure.

8. Select the Advanced tab.
9. Select Speed and Duplex and then choose Auto Negotiation.
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10. Select the Power Management tab.
11. Select the ‘Allow the computer to turn off this device to save power’ 

checkbox.
12. Select OK.
13. Restart your computer.

Configure System Software Specify FactoryTalk Directory Location

Specify the FactoryTalk Directory location.
1. On the virtual image desktop, select the Programs icon and choose 

Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory 
Location. 

2. In the FactoryTalk Directory Server Location Utility dialog box, select 
Browse (ellipsis '…').

3. In the FactoryTalk Directory Server Configuration dialog box, select 
Remote Computer. Enter the name of your PASS server, or select Browse 
(ellipsis '…'), search for, and select your PASS server.

4. On the FactoryTalk Directory Server Location Utility dialog box, select 
OK to accept the changes. 

5. Log in to the FactoryTalk server when prompted.
6. Restart the virtual machine.

IMPORTANT Browse can be inactive if Network Discovery and File Share are not 
enabled.
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Configure FactoryTalk View SE Client

The FactoryTalk View SE Client software is pre-installed on the OWS. This 
provides an interface to connect to the HMI on the PASS-C. 

You can launch the FactoryTalk View SE Client Wizard to:
• Create a FactoryTalk View SE Client configuration file
• Edit an existing FactoryTalk View SE Client configuration file
• Run an existing FactoryTalk View SE Client configuration file

Configure Services for Historian PIPerfmon

FactoryTalk Historian, on the PASS-C, uses a PIPerfmon interface to collect 
performance data from computers within the PlantPAx system. 

Remote computers, such as the OWS, require some configuration to allow 
PIPerfMon access to local performance counters.
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1. Enable the Remote Registry service and set the startup type to 
Automatic. 

2. Create a user account (local or domain) named PIPerform and grant it 
the role of Performance Monitor Users. 

3. Modify the Performance Counter DLL Host service to Log on as the 
PIPerfMon account on all OWS computers. 
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Configure FactoryTalk AssetCentre Client

The FactoryTalk AssetCentre Client software is pre-installed on the OWS. This 
provides an interface to connect to the AssetCentre Server on the PASS-C. 

You can launch the FactoryTalk AssetCentre Client to configure security, 
contacts, assets, disaster recovery schedules, and additional features as 
described in the FactoryTalk AssetCentre user manual.
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Notes:
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Appendix A

Software Product keys and Activations

This section discusses software activations and licenses that are required for 
PlantPAx® virtual templates and ISO images.

Microsoft® and Rockwell Automation require software licenses to fully utilize 
their software.

• Microsoft uses a Product Key to activate the Windows operating system, 
remote desktop services, and Office apps.

• Rockwell Automation uses an Activation File to activate FactoryTalk® 
software packages

Microsoft Product Keys The PlantPAx System 5.0 virtual templates and ISO images utilize Windows 
Server 2016 Standard and Windows 10 Enterprise LTSB 2019 operating 
systems.

Both operating systems initially power on with the Windows Out of Box 
Experience (OOBE), where you have the option to enter a product key or skip 
to the next step. Subsequent boots prompt to enter a product key that must be 
purchased from Microsoft to activate the operating system.

Slmgr.vbs Tool

If you want to do something more advanced like remove a product key, force 
an online activation, or extend the activation timer, you need Slmgr.vbs.

This command-line tool is included with Windows, and provides options 
unavailable in the standard activation interface that is provided on the Update 
& Security > Activation screen in the Settings app

1. Right-click the Windows  icon and choose 'Command Prompt 
(Admin)'. 

2. At the command prompt, type 'slmgr /ipk <Product key>' and press Enter 
to add your volume license key. 

3. Click OK when a dialog box appears informing you that the product key 
installed successfully.

4. At the command prompt, type 'slmgr /ato' and press Enter to activate 
Windows.

5. Click OK when a dialog box appears informing you that the product 
activated successfully.

6. Close the command prompt window.
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Rockwell Automation 
Activation Files

For continuous use of FactoryTalk products and other Rockwell Automation® 
software products, computers running the software must have access to 
activation files. FactoryTalk Activation software provides a secure, software-
based system for activating Rockwell Automation software products and 
managing software activation files. With FactoryTalk Activation software, 
there is no need for a physical master disk or any physical media. Instead, 
activation files are generated and distributed electronically.

Concurrent activations are locked to a central activation-server computer on 
the network. The activation server manages a pool of activations are assigned 
automatically to clients that need them. These activations are returned 
automatically to the activation server pool when the software stops running on 
the client, or when the client computer shuts down. 

Client computers must be configured to obtain floating activations from the 
activation server. A continuous network connection is also required for clients 
to use floating activations. After a client obtains a floating activation, if the 
activation server detects that the client has been disconnected, the activation is 
returned to the server pool.

FactoryTalk Activation Manager

FactoryTalk Activation software provides a secure, software-based system to 
apply Rockwell Automation licenses for continuous use of FactoryTalk 
software and other Rockwell Automation software products.
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Consideration Details

Software that is not activated

If the components you have installed cannot be activated, for example, because the activation server is 
unavailable, then the software continues to run for up to 7 days. The seven-day grace period provides time to 
correct the problem with acquiring activations, without disrupting critical applications. If activation is restored 
within 7 days, normal operations resume. If activation is not restored, the grace period expires. After the grace 
period expires, if you restart the components and activation remains unavailable, the software runs for 2 hours 
in Demo mode.

Location of activation server

Activations for Rockwell Automation software can be stored local to the system element containing the Rockwell 
Automation software in question or remotely depending on your preferences and needs. Typically critical 
system elements keep their activations locally in case the connection with the remote activation location is lost. 
If you want to remotely activate Rockwell Automation software in non-critical system elements consider storing 
them in a system element with uninterrupted connection to your PlantPAx DCS.  Keep in mind the information in 
Consideration section “Software that is not activated” when using a remote location for activations.

Options for adding activation files to the PASS

To make concurrent floating activations available to activation clients, first you must download the activation 
files to the activation server computer, from the Rockwell Automation Activation window.
If the PASS has internet access, see ‘Open Activation Manager’ in the PlantPAx Distributed Control System 
Infrastructure Configuration User Manual, publication PROCES-UM100.
If the PASS does not have internet access, the activations can be downloaded on another computer with internet 
connectivity and then transferred to the PASS.

Activation file types

There are two types of activation files:

Older Flexera (.LIC) non-encrypted files that are supported by older and current software versions that can be 
stored locally (C:\Users\Public\Documents\Rockwell Automation\Activations) or on a Flexra USB Dongle.

Newer CodeMeter (.wibu) encrypted files that are supported by current and future software versions that can be 
stored locally (C:\ProgramData\CodeMeter\CMAct) or on a CM USB Stick.

The FactoryTalk software that is installed in the PlantPAx System 5.0 virtual templates and ISO images are 
current versions that compatible with Flexera and CodeMeter activations. CodeMeter is the preferred activation 
file type going forward.
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Notes:
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